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Unit – I 
 
Introduction to Computers: Definition of computer, Characteristics and limitations of 

Computers, Functional Block diagram of digital computers, Functions of Control Unit and ALU in 

CPU, Concept of Primary memory (RAM & ROM) and secondary memory, Magnetic Hard disks, 

Magnetic Tapes, Floppy disk, CD-ROM, Input / Output Devices. 

Networks: Definition - Network types: LAN, MAN, WAN -Network Topologies: Mesh, Bus, Star, 

Ring, Hybrid – Protocols. 

 
Introduction to Computers:  
 
Meaning of a Computer:   

Computer is a machine that can solve problems by accepting data performing certain operations 

and presenting the results of those operations under the direction of detailed step-by-step 

instructions. Such a set of sequenced instructions, which cause a computer to perform particular 

operations, is called a program. The term computer has been derived from the word “COMPUTE” 

which means calculate. 

Definition of a computer 
 

Computer is an electronic device, used for performing calculations and controlling 

operations that be either expressed in logical or numerical terms. 

⮚ It stores and process data in binary form according to instructions given to it 

in a variable program. 

⮚ Computer need to be told exactly what to do and how to do to accomplish a 

task 

⮚ It is a combination of hardware and software 

⮚ Software is the set of instructions given to the computer to perform a task 

⮚ The physical parts that make up computer are called hardware, which are 

made of circuits and transistors 

The three main operations of computer are 
1) Takes in data and instructions (input) 
2) works with the data (processing) 
3)  puts out information (output) 
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Characteristics of a Computer: 

The following are the main characteristics of a computer- 

1. Speed: Computer is able to process the data and give the output in fractions of 

seconds such that required information is available to the user on time and 

hence enables him to take right decisions at the right time.  

2. Accuracy: Computer is error free. There is no scope for inaccuracy in the results 

given by the computer. Incorrect calculations, errors, mistake do not take place 

in a computer system. If there errors they are due to the errors in the 

instructions given by the programmer, inaccurate data, inconsistent data or 

defective programs as well as defective system designs. Since the computer is 

capable of doing only what it is instructed to do, fault instructions for data 

processing may lead to faulty results this is known as GIGO (Garbage in Garbage 

Out) 

3. Reliable: Today, computer is extensively used because of their reliability. The 

output generated by the computer is very reliable to the extent that the input 

is reliable. 

4. Storage capacity: Another important characteristic of a computer is that it has 

brain of its own with brilliant memory. It can accept and store any information 

for a long time. It stores large amount of data and can recall information 

instantly. The main memory of the computer is relatively small and holds certain 

amount of information. Therefore, the data is stored in secondary memory 

5. Versatile: The computer performs three basic operations. It accepts information 

from the user; secondly it performs the basic arithmetic operations and logical 

operations and finally generates the desired output in the desired form. 

6. Automatic (Programmable): Computer is a device, which is more than a 

calculator. Once instructions are given to the system it works automatically 

without any human intervention until the completion of program until it meets 

logical instruction to terminate the job. 

7. Diligent: A computer is a device, which is indefatigable (untiring) and therefore 

does not feel tired nor gets distracted like a human being. All the instructions 

are performed at same speed and accuracy 
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8. Recreation: In recent years, computers were used mainly for entertainment and 

amusement, like computer games and other programs, computer animation 

gives life and movement to inanimate objects. Multimedia too helped in 

popularizing the use of computers. 

9. Networking capacity: A computer can be connected with other computers. This 

feature of connectivity with other computers leads to the evolution of computer 

networking. 

10. Compactness: Now-a-day’s size of computers has decreased o lot due to 

increased technology. The laptop and Notebook computers can be taken 

outside. 

Limitations of A Computer: 

Like any modern technology computers is also not free from limitations- 

⮚ Computer is a machine and therefore it is only a device that needs 
human skill to operate. 

⮚ It does not work on its own and needs set of instructions to be given. 

⮚ It does not have natural intelligence and hence has to be instructed 

about every step in detail. 

⮚ It is not a decision maker and has to be programmed to take an action if 

some conditions prevail. 

⮚ Finally, it does not learn by experience unlike intelligent human beings. 

 

Elements of a Computer: 

A computer consists of three basic elements/components such as hardware, 

software and memory.  

 

Hardware:  

✔ The physical devices that make up a computer are referred to as hardware. 

✔ It includes the tangible aspects of computers and can be touched such as 

mouse, printers, monitor, microphone, scanner etc.  

✔ Hardware is usually used for input and output purposes. It takes instructions 

from the user from input devices such as mouse, key board etc and displays the 
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output (after processing) on the other hardware devices such as monitor, LCDs, 

scanner, printers etc.  

 

 

Software:  

✔ The software of the computer includes operating system which executes all 

the programs and instructions given by the user.  

✔ The computer software itself is categorized into two  
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1. System Software  

⮚ It is collection of programs designed to operate, control, and extend the 

processing capabilities of the computer itself. System software are generally 

prepared by computer manufactures. These software products comprise of 

programs written in low-level languages which interact with the hardware at a 

very basic level. System software serves as the interface between hardware and 

the end users. 

⮚ Includes the software execution by the computer itself such as Windows and 

DOS. 

 

2. Application Software  

⮚ Application software products are designed to satisfy a particular need of a 

particular environment. 

⮚ Application software may consist of a single program, such as a Microsoft's 

notepad for writing and editing simple text. It may also consist of a collection of 
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programs, often called a software package, which work together to accomplish 

a task, such as a spreadsheet package. 

 

 

FUNCTIONAL BLOCK DIAGRAM OF COMPUTER: 

• A Computer, like a human brain, receives data and instruction, stores them and 

processes the data according to the instructions given to it. 

• It receives data from input devices, stores them in memory and displays them 

through on an output device 

 

 
 

Central Processing Unit (CPU) 

CPU is the component of computer system with the circuitry to control 

interpretation and execution of instructions. It performs the process in parts of 

Input-Process-Output cycle. The components of CPU are mounted (Fixed) on the 

main circuit board, called the “motherboard”. 

The various components of a Central Processing Unit are: 
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1. Arithmetic Logic Unit (ALU). 

2. Control Unit. 

Arithmetic and Logic Unit (ALU) 

⮚ It is that part of CPU where actual data processing occurs.  

⮚ All mathematical operations (+, -, *, /) and all comparisons (>, <, =) take place 

in this unit. 

⮚ In addition to arithmetic functions, the ALU also performs logic functions.  

⮚ A logic function is one where numbers or conditions are compared to each 

other.  

⮚ Circuits in the ALU are generally used to compare two numbers by 

subtracting one from the other.  

⮚ The sign (negative or positive) and the value of the difference tell the 

processor that the first number is equal to, less than, or greater than the 

second number.  

⮚ Alphabetic data may also be compared according to an assigned order 

sequence. 

 

Control Unit 

⮚ It is a component of CPU that control and coordinates the flow of data 

between different components of computer 

⮚ It interprets instructions it receives from memory and directs the sequence 

of events necessary to execute the instruction.  

⮚ Control Unit uses a system clock, which synchronizes (manage) all tasks by 

sending out electrical pulses.  

⮚ Clock speed (the number of pulses or clocks per second) is measured in 

Megahertz (MHz) and is the main element in determining the speed of the 

processor.  

⮚ Computer speed is also measured in the number of instructions completed 

per second, or Millions of instructions per second (MIPS). 
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MEMORY 

Memory is the most essential element of a computing system because without it 

computer can’t perform simple tasks. Computer memory is a generic term for all of 

the different types of data storage technology that a computer may use, including 

RAM, ROM. There are two types of memory:  

1. Primary Memory 

2. Secondary Memory 

 

1. PRIMARY MEMORY (MAIN MEMORY):  

Primary memory holds only those data and instructions on which computer is 

currently working. It has limited capacity and data is lost when power is switched 

off. It is generally made up of semiconductor device. These memories are not as 

fast as registers. The data and instruction required to be processed reside in main 

memory. 

 

Primary storage or main memory stores three types of information for very brief 

periods of time:   

✔ Data to be processed by the CPU. 

✔   Instructions for the CPU as to how to process the data. 
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✔ Operating system programs that manage various aspects of the 

computer’s operation. 

There are four main types of primary storage  

1. Random access memory (RAM)  

2. Read-only memory (ROM). 

3. Cache memory and  

4. Register  

 

1. Random Access Memory(RAM): 

This is that part of primary storage where data and program instructions are 

held temporarily while being manipulated and executed. It is called Random Access 

Memory because any of the locations on a chip can be randomly selected and used 

to directly store and retrieve data and instructions. RAM is volatile i.e. it is depends 

on a steady supply of electricity and when the power is shut off, everything stored 

is lost.  

Access time in RAM is independent of the address i.e., each storage location 

inside the memory is as easy to reach as other locations and takes the same amount 

of time. Data in the RAM can be accessed randomly but it is very expensive. 

RAM chip may be classified as: 

● DRAM: DRAM stands for Dynamic RAM, and it is the most common type of RAM 
used in computers. The oldest type is known as single data rate (SDR) DRAM, 
but newer computers use faster dual data rate (DDR) DRAM. DDR comes in 
several versions including DDR2, DDR3, and DDR4, which offer better 
performance and are more energy efficient than DDR. However different 
versions are incompatible, so it is not possible to mix DDR2 with DDR3 DRAM in 
a computer system. DRAM consists of a transistor and a capacitor in each cell. 

● SRAM: SRAM stands for Static RAM, and it is a particular type of RAM which is 
faster than DRAM, but more expensive and bulker, having six transistors in each 
cell. For those reasons SRAM is generally only used as a data cache within a CPU 
itself or as RAM in very high-end server systems. A small SRAM cache of the 
most imminently-needed data can result in significant speed improvements in a 
system 
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2. Read Only Memory (ROM): 

ROM stands for read-only memory, and the name stems from the fact that while 
data can be read from this type of computer memory, data cannot normally be 
written to it.  It is a very fast type of computer memory which is usually installed 
close to the CPU on the motherboard. ROM is a type of non-volatile memory, which 
means that the data stored in ROM persists in the memory even when it receives 
no power – for example when the computer is turned off. In that sense it is similar 
to secondary memory, which is used for long term storage. The ROM usually 
contains "bootstrap code" which is the basic set of instructions a computer needs 
to carry out to become aware of the operating system stored in secondary memory, 
and to load parts of the operating system into primary memory so that it can start 
up and become ready to use. 

 ROM is mainly of three types: 

I. Programmable read only memory (PROM) allows a chip to be programmed 
by the user for converting critical and lengthy operations into micro 
programs that are fused into a chip. The user buys a blank PROM and enters 
the desired contents using a PROM program. Inside the PROM chip there are 
small fuses which are burnt open during programming. It can be 
programmed only once and is not erasable. Once they are in a hardware 
form, they can be executed at a very high speed and can’t be altered. 
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II. Erasable PROM (EPROM) can be erased and reprogrammed. The EPROM 

chip has a small window on top allowing it to be erased by exposing it to 

ultra-violet light for duration of up to 40 minutes. After reprogramming the 

window is covered to prevent new contents being erased 

III. Electrically Erasable PROM (EEPROM) is programmed and erased 

electrically. It can be erased and reprogrammed about ten thousand times. 

Both erasing and programming take about 4 to 10 ms (milli second). In 

EEPROM, any location can be selectively erased and programmed. EEPROMs 

can be erased one byte at a time, rather than erasing the entire chip. Hence, 

the process of re-programming is flexible but slow. 

 

Difference between RAM and ROM: 

 
 

 

3. Cache Memory: 

Cache memory is typically integrated directly with the CPU chip or placed on a 

separate chip. Many processors also have built-in specialized storage elements that 

http://searchmobilecomputing.techtarget.com/definition/memory
http://whatis.techtarget.com/definition/CPU-central-processing-unit
http://whatis.techtarget.com/definition/chip
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are used for specific processing and 

control purposes. A 

computer  microprocessor can access 

more quickly than it can access regular 

RAM. 

 The basic purpose of cache 

memory is to store 

program instructions that are frequently re-referenced by software during 

operation. Fast access to these instructions increases the overall speed of the 

software program. 

One element used during processing operations is a high speed Buffer 

Memory (cache memory), which is both fast and expensive, as compared to 

primary storage. It is a small amount of memory typically of 256 or 512 kilobytes. 

L1 and L2 are levels of cache memory in a computer. L1 is "level-1" cache 

memory, usually built onto the microprocessor chip itself. L2 (that is, level-2) cache 

memory is on a separate chip that can be accessed more quickly than the larger 

"main" memory. 

 

4. Registers 

Registers are a special high-speed storage area within the CPU. All data must be 

represented in a register before it can be processed. The register can contain 

the address of a memory location where data is stored rather than the actual data 

itself. The number of registers that a CPU has and the size of each (number of bits) 

helps to determine the power and speed of a CPU.  

 

The CPU contains a number of special-purpose registers 

⮚ Instruction Register (IR): The instruction register holds the instructions. 

⮚ Memory Data Register (MDR): The memory data register holds the piece of 

data. 

⮚ Memory Address Register (MAR): The memory address register holds the 

address. 

http://whatis.techtarget.com/definition/microprocessor-logic-chip
http://searchsoftwarequality.techtarget.com/definition/program
http://whatis.techtarget.com/definition/instruction
http://searchsoa.techtarget.com/definition/software
http://whatis.techtarget.com/definition/access
http://www.webopedia.com/TERM/S/storage.html
http://www.webopedia.com/TERM/C/CPU.html
http://www.webopedia.com/TERM/D/data.html
http://www.webopedia.com/TERM/A/address.html
http://www.webopedia.com/TERM/M/memory.html
http://www.webopedia.com/TERM/S/store.html
http://www.webopedia.com/TERM/B/bit.html
http://en.wikipedia.org/wiki/Instruction_register
http://en.wikipedia.org/wiki/Memory_data_register
http://en.wikipedia.org/wiki/Memory_address_register
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⮚ Program Counter Register (PC): The program counter holds the location of the 

next instruction to be fetched from memory.  

⮚ Accumulator Register: It is used as the default location to store any calculations 

performed by the arithmetic and logic unit. 

 

2. SECONDARY MEMORY: 

Secondary (Auxiliary) storage is the non-volatile memory that is stored externally 

to the computer. A secondary medium usually used for the storage of large amount 

of data for permanent or long-term storage of data or programs. While the 

secondary media can hold much more data than primary storage, access to the data 

is slower. 

 

The benefits of secondary storage are: Capacity, Reliability and Convenience 
 
Different secondary storage media can be ranked according to the following 

criteria: 

⮚ Retrieval speed - The access time of a storage device is the time it takes to locate 

and retrieve the stored data. A fast access time is preferable for any storage 

media. 

⮚ Storage capacity- A device’s storage capacity is the ability to store data. A large 
storage capacity is desired. 

⮚ Cost per bit of capacity- Low cost is preferred. 
 

Secondary storage media with all sizes of computers can be broadly categorized 

into: 

1.  Magnetic tape. 
2.  Magnetic disk. 
3.  Optical disk. 

1. Magnetic tape:  

 Magnetic tape is a one-half or one-fourth inch ribbon of Mylar (a plastic like 

material) coated with a thin layer of iron-oxide material. It is a medium that is often 

selected to store large files that are sequentially accessed and processed. Its data 

http://en.wikipedia.org/wiki/Program_counter
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density (the number of characters that can be stored in a given physical space) is 

high and its transfer rate (the speed with which data can be copied into processor 

storage) is fast. 

Advantages:        

⮚ Low cost and ease of handling.  

⮚ High data density 
Limitations of Magnetic Tape: 

⮚ Lack of direct access to records. 

⮚ Environmental problems-sensitivity to dust, humidity and temperature 
levels. 

 

 

2. Magnetic disk:  

A magnetic disk is a Mylar or metallic platter on which electronic data are stored. 

Unlike magnetic tapes, data on magnetic disks can also be read randomly. The data 

are recorded as tiny invisible magnetic spots on its iron oxide coating.  

 It consists of two or more metal platters mounted on central spindle like a stack. 

Each platter is covered with a magnetic coating, and the entire unit is encased in a 

sealed chamber. The motor spins the platter and sets the read/write head on the 

disk to read from or to write on to the disk. The top most layer of the top platter 

and bottom most layer of the bottom platter is not used to storing a data as they 

may contain some dust particles. These heads are fastened to an arm in a disk 

storage device so that they can be moved quickly and directly to any disk location 

to store or retrieve data. 

 The surface of the magnetic disk is divided into number of invisible concentric 

circles called “tracks”. The tracks are further subdivided into “sectors”, “blocks” etc. 

each its own unique addresses to facilitate the location of data. Disk moves on a 

vertical rotating spindle. Data on magnetic disks can be read randomly.  

  

The access time for data stored on a magnetic disk is determined by two factors: 

1. The seek time i.e. the time required for positioning read/write head over the 
proper track. 
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2. The search time i.e. the time required for spinning the required data under 
the head. 

Magnetic disks come in various sizes. They can be 

portable or permanently mounted in their storage 

devices, disk drives. They can be made of rigid metal 

(Hard Disks) or flexible plastic (Floppy Diskettes).  

Advantages of Magnetic Disk 

● Data records can be stored for both sequential and direct-accessing. 

● High speed of access and update as no sorting of transactions. 

● On-line disk records of several related files can be updated simultaneously 

by a single input transaction. 

Limitations of Magnetic Disk 

● Risk of loss of data – Records may be lost in case of writing of new records or 

drive failure. Therefore, special backup procedures are required for disk 

records protection. This is not so in the case of magnetic tape records. 

● Data insecurity – It is easier to maintain the security of magnetic tape files 

than that of magnetic disk files.  

3. Optical Technology: 

Optical technology involves the use of laser beams highly concentrated 

beams of light. It comes in the form of Optical laser disk, Optical 

card and Optical tape. 

 

Optical Laser Disk: A common version of the optical disk is the CD-

ROM (compact disk, read–only memory). While not suited to applications where 

data changes, they are very convenient for storing data that remains constant. CD-

ROM [Compact Disc Read Only Memory] is a Compact Disc contains data accessible 

by a computer.  

⮚ The CD-ROM is also known as a laser disc, which is shiny metal like disk. The 

diameter of the disk is 5.25 inches (or) 12 cm disk. Information of 650 MB 

can be stored, which is equal to nearly 2, 50,000 pages of printed text. 

⮚ The data is recorded as deep holes on the disk surface or burning microscopic 

bits. 
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⮚ CD-ROMs are popularly used to distribute computer software, including 

games and multimedia applications, though any data can be stored. 

⮚ The CD-ROM s are pre-recorded disks used for storing a large amount of data 

(or) information.  

 

Optical Card: The Optical card, or laser card, is the size of a credit card and has an 

optical laser-encoded strip that can store approximately 2 megabytes of data. 

These cards have many potential uses, most notably for storing credit records or 

medical histories.  

 

Optical Tape: Optical tape is similar in appearance to magnetic tape, but data are 

stored by optical laser techniques. Optical tapes, which are in cassette form, can 

store over 8 gigabytes each providing a total storage of about 1 terabyte (1,000 

gigabytes). Like other optical methods of data storage, optical tape is read only.  

   

 

Floppy Disk Drive (FDD): 

⮚ A floppy disk is a magnetic storage medium for computer systems. The floppy 

disk is composed of a thin, flexible magnetic disk sealed in a square plastic 
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carrier. In order to read and write data from a floppy disk, a computer system 

must have a floppy disk drive (FDD).  

⮚ A floppy disk is also referred to simply as a floppy. Since the early days of 

personal computing, floppy disks were widely used to distribute software, 

transfer files, and create back-up copies of data. When hard drives were still 

very expensive, floppy disks were also used to store the operating system of a 

computer.  

⮚ Floppy disks store much less data than a CD-ROM disk or USB flash drive. A 

normal 3½ inch disk can store 1.44 megabytes of data. This is usually enough for 

simple text documents. 

⮚ A number of different types of floppy disks have been developed. The first 

floppy disks were 8 inches (20 cm) across. In the late 1970s, floppy disks became 

smaller, with the arrival of 5.25-inch (13.3-cm) models, and the final floppy 

disks, which debuted in the 1980s, were 3.5 inches (9 cm) in diameter.  

⮚ Data were arranged on the surface of a disk in concentric tracks. The disk was 

inserted in the computer’s floppy disk drive, an assembly of magnetic heads and 

a mechanical device for rotating the disk for reading or writing purposes. A small 

electromagnet, called a magnetic head, wrote a binary digit (1 or 0) onto the 

disk by magnetizing a tiny spot on the disk in different directions and read digits 

by detecting the magnetization direction of the spots. 

https://simple.wikipedia.org/wiki/Information
https://simple.wikipedia.org/wiki/CD-ROM
https://simple.wikipedia.org/wiki/USB_flash_drive
https://simple.wikipedia.org/wiki/Inch
https://simple.wikipedia.org/wiki/Megabyte
https://www.britannica.com/technology/bit-communications
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Compact Disk (CD): 

⮚ A compact disc, or CD, is a thin circular piece of equipment that can be used to 
store data, including graphics and music. It was developed in the late 1970s and 
was the first mainstream way to digitally store music. The term "compact" refers 
to its size relative to traditional phonograph records rather than other digital 
formats. Standard CDs are 12 centimeters, or about 4.7 inches, in diameter. 

⮚ CDs are read using a laser and a light receptor that can capture the pattern of 
reflections off the surface of the CD as it is rotated in a drive or audio player. 
Audio CDs can store up to 74 minutes of music or other sounds, and a data CD 
can store between 650 and 700 megabytes. 

⮚ A CD is usually around 12 centimeters (4.5 inches) in diameter and consists of 

a couple of thin circular layers that are attached one on top of another. 

⮚ Most of a CD is composed of a plastic called polycarbonate. The bottom layer 

is a polycarbonate layer where data is encoded by using tiny bumps on the 

surface. Above this layer is a reflective layer, which is typically made of 

aluminum (gold is also used, although quite rarely). 
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INPUT AND OUTPUT DEVICES: 

The CPU provides the means for the fast and efficient processing of data into usable 

information. For computer processing, data needs to be entered into the computer 

(input) and the result of processing needs to be communicated to the user 

(output).  Any hardware item which is attached to the main unit of a computer that 

houses the CPU is referred to as a Peripheral Device.  

 

INPUT DEVICES: 

An input device is a peripheral device through which data are entered and 

transformed into machine-readable form. Let us have a look at various input 

devices available. 

1. Keyboards 

Standard keyboard is the most common and familiar input device. A typical 

computer keyboard contains all letters, numbers, symbols of a regular typewriter, 

plus other keys. Every key on the keyboard underneath it consists of a tiny chip 

called as keyboard controller, when a key is pressed the controller places the code 

into the part of the memory called keyboard buffer. The buffer temporarily holds 

the data till it is processed. The signal the keyboard sends to the computer is called 



Unit – I  EIT 

ST Joseph’s Degree & PG College  20 
 

as interrupt. The keyboard sends an interrupt request to the 

system software and the data is processed. 

S.No. Keys Description 

1 Typing Keys 
These keys include the letter keys (A-Z) and digits 
keys (0-9) which generally give same layout as that 
of typewriters. 

2 Numeric Keypad 

It is used to enter numeric data or cursor 
movement. Generally, it consists of a set of 17 keys 
that are laid out in the same configuration used by 
most adding machine and calculators. 

3 Function Keys 

The twelve functions keys are present on the 
keyboard. These are arranged in a row along the top 
of the keyboard. Each function key has unique 
meaning and is used for some specific purpose. 

4 Control keys 

These keys provide cursor and screen control. It 
includes four directional arrow key. Control keys 
also include Home, End, Insert, Delete, Page Up, 
Page Down, Control(Ctrl), Alternate(Alt), 
Escape(Esc). 

5 
Special Purpose 
Keys 

Keyboard also contains some special purpose keys 
such as Enter, Shift, Caps Lock, Num Lock, Space bar, 
Tab, and Print Screen. 

 

2. Mouse 

A mouse is a pointing device. It usually contains one or three buttons: as the user 

rolls it on a flat surface, the mouse controls cursor movement on the screen. When 

the user presses one of the buttons, the mouse either marks a place on the screen 

or makes selections from data on the screen. It can be used for many applications 

ranging from games to designing products with graphics. It can be used as an 
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alternative to keyboard or it can be used in combination with a keyboard to 

enhance input operations. 

Advantages: 

● Easy to use 

● Not very expensive 

● Moves the cursor faster than the arrow keys 
of keyboard. 
 

3. Joystick   

A joystick is a most popular input device used to play video games. A 

joystick uses a level to control the position and speed with which the 

joystick is moved into digital signals that are sent to the computer to 

control the cursor movement. 

4. Track Ball         

A track ball uses a hard sphere to control cursor movement. The 

ball can be rotated by hand in any direction. The track ball 

translated the sphere’s direction and speed of rotation into a 

digital signal, used to control the cursor. 

5. Touch Screen 

A touch screen registers input when a finger or other object 

comes in beams and ultrasonic acoustic waves. Infrared beams 

crisscross the surface of the screen and when a light beam is 

broken, that location is recorded. 

6. Light Pen 

A light pen is also a pointing device like mouse. It can be used to choose a displayed 

menu option. The pen contains a photocell placed in a small tube. As the user 

moves the tip of the pen over the surface of the screen, it detects the light coming 

from a limited field of view. The light from the screen causes the photocell to 

respond and this electric response is transmitted to the process, which can identify 
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the menu option that is triggering the photocell. Light pen is 

useful for graphics work, especially for Computer Aided 

Design (CAD) purposes. 

7. Magnetic Ink Character Recognition (MICR) 

Magnetic Ink Character Recognition (MICR) is an interpretation by computer of a 

line of character written in special magnetic ink. These characters can 

be read by human eye as well. 

There are several advantages associated with the use of MICR:  

● Checks may be roughly handled, folded, smeared, and stamped. 
But they can still be read with a high degree of accuracy. 

● People can easily read the magnetic ink characters. 
The main limitation of MICR is that only the 10 digits and 4 special characters 

needed for bank processing are used. No alphabetic characters are available. 

8. Magnetic strips  

They are thin bands of magnetically encoded data that are found at the back of 

usually, Credit cards, Debit cards etc. the data stored on the card vary from 

application to another. Data in the form of magnetic strips cannot be seen or 

interpreted by simply looking at the card and so it can be highly sensitive or 

personal. 

9. Optical Recognition / Scanners 

Optical Recognition when a device scans a printed surface and translates the image 

the scanner sees into a machine-readable format that is understandable by the 

computer. Optical Recognition can be of the following 

types 

i. Optical Mark Recognition (OMR) 

It uses mark sensing to scan and translate, based on its 

location, which is a series of pen or pencil marks into a computer readable form. 

For instance, the objective type multiple choice question paper we get in the bank 
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recruitment exam. A computerized optical mark reader scores the tests by 

identifying the position of the mark 

ii. Optical Bar Recognition (OBR)  

This is slightly more sophisticated type of optical 

recognition. An optical bar reader recognizes and 

interprets bar codes or product codes which are arranged 

to represent data, such as the name of the manufacturer, 

and the type of the product etc. on the basis of the width 

of the lines. A scanner reads the bar code, and the computer then matches the 

price and product. 

 

 

iii. Optical character recognition (OCR)  

 This is most sophisticated type of optical recognition. An 

optical card reader works in much the same way as a human 

eye. It recognizes specially shaped numerical and alphabetic 

characters.  

10. Microphone 

A microphone can be attached to a computer to record sound (usually through a 

sound card input or circuitry built into the motherboard). The sound is digitized—

turned into numbers that represent the original analog sound waves—and stored 

in the computer for later processing and playback. 

OUTPUT DEVICES: 

An Output Device is a peripheral device that allows a computer to 

communicate information to humans or another machine by accepting data from 
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the computer and transforming them into a usable form. The result of processing 

is also often referred as output. 

Output that can be understood by humans can be in the form two types: Hard copy 
& Soft copy. 

▪ Hard Copy is the output on paper and can be read immediately or 

stored and read later. This is a relatively stable and permanent form of 

output. 

▪ Soft Copy is usually a screen-displayed output. It is a transient form of 

output and is lost when the computer is turned off. 

1. Visual Display Unit (Monitor) 

A monitor is a television like device used to display input data or information, 

allowing users to view the results of processing. The combination of monitor with 

the keyboard is called a terminal. 

Quality of a monitor often judged as in terms of resolution, which is a 

measure of the number of picture elements, or pixels, a screen, contains. A pixel is 

the smallest increment of a display screen that can be controlled individually. The 

higher the number of pixels, the clearer and sharper is the image. Screens for the 

monitor are of two types: 

 

1. Cathode Ray Tube (CRT): On this type of screen, a data image can be 

produced by moving an electron beam across a phosphor-coated screen. CRT 

has display screen 25 lines of 80 characters each. It is used in most desktop 

monitors. Some CRT screens are monochrome (1 color) while other produce 

many color. 

2. Flat Panel Display: To overcome the limitation of CRT like bulky in size, high 

power consumption, flickering screen Flat panel display is used. The most 

common form of flat panel display is the Liquid Crystal Display (LCD), which 

produces images by aligning molecular crystals and an LED display which 

uses an array of light-emitting diodes as a video display. An LED panel is a 

small display, or a component of a larger display.  
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2. Printer  

Produces output usually in the form of text on a paper. 

Printers are classified based on the contact between the printer head and the paper 

into  

● Impact printers  

● Non-Impact printers 

 

 

 

Impact printers: 

Impact Printers use a print head containing a number of metal pins which strike an 

inked ribbon placed between the print head and the paper.  

 

Dot Matrix Printer 

It uses printer heads containing a 9-24 pins these pins produced pattern of dots on 

the paper to form a character. Dot matrix printers are very popular as they are 

relatively inexpensive and typically print at speed of 100-600 characters per 

second. These printers can give us draft quality, standard quality and near letter 

quality prints 

Daisy Wheel Printer: This printer gives us letter quality print but is slow, typically 

25 to 55 characters per second. It is a circular printing element which has a plastic 

or metal wheel on which the shape of each character stands out in relief. A hammer 

http://www.webopedia.com/TERM/C/character.html
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presses the wheel against a ribbon, which in turn 

makes an ink stain in the shape of the character on 

the paper. Daisy-wheel printers produce letter-

quality print but cannot print graphics. 

 

Line Printers: The line printer is a form of high speed 

impact printer in which one line of type is printed at a 

time. Print speeds of 600 to 1200 lines-per-minute (approximately 10 to 20 pages 

per minute. Types of line printers 

• Drum Printer 

• Chain Printer 

 

Typical typeface of a drum printer with staggered characters. 

A fixed font character set is engraved onto the periphery of a number of print 

wheels. 

The wheels, joined to form a large drum (cylinder), spin at high speed and paper 

and an inked ribbon is stepped (moved) past the print position. As the desired 

character for each column passes the print position, a hammer strikes the paper 

from the rear and presses the paper against the ribbon and the drum, causing the 

desired character to be recorded on the continuous paper. 

 

Non-Impact Printers: 

Non-impact printers are much quieter than impact printers as their printing heads 

do not strike the paper. The main types of non-impact printer are: 

1. Thermal Printer  

Characters are formed by heated elements being placed in contact with 

special heat sensitive paper forming darkened dots when the elements reach a 

critical temperature. 

2. Laser Printer 

 When speed and quality are required and cost is no factor a laser printer 

is the solution. They produce images on paper by directing a laser beam at a 

minor, which bounces the beam on to a drum. The laser leaves a negative charge 

http://www.webopedia.com/TERM/G/graphics.html
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on the drum to which positively charged black toner 

powder will stick. As the paper rolls by the drum, the toner 

is transferred to the paper. Laser printer uses buffer to 

store an entire page at a time that is why they print very 

fast at rate of approximately 21,000 lines or 437 pages per 

minute. 

 

3. Ink-Jet Printer 

Ink-Jet printer forms character on paper by 

spraying ink from tiny nozzles through an electrical field 

that arranges the charged ink particles into characters 

at the rate of approximately 250 characters per second. 

The ink is absorbed into the paper and dries instantly. Various colors of ink can 

be used. Although this might sound like a messy way of printing, ink-jet printers 

are reliable, but expensive. 

 

3. Plotter 

 A Plotter reproduces drawings using pen that are 

attached to movable arms. The pens are directed across 

the surface of a stationary piece of paper. High quality bar 

graphs, pie charts created with a plotter give a very good 

quality product. 

4. Sound Card and Speakers 
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A sound card captures sounds and changes them into digital binary numbers that 

are stored as files in your computer. 

When outputting sounds the sound card reverses the 

process and changes binary data held in the sound files into 

analogue signals that are used control the speakers attached 

to the computer. Speakers convert analogue audio signals 

into the equivalent air vibrations in order to make audible 

sound. A pair of speakers plugs into the computer’s sound card. 

5. Projector 

 

Projector may refer to: 

● Image projector, a device that projects an image 

on a surface 3D projection, a method of mapping 

three-dimensional points to a two-dimensional 

plane.  

● Video projector, a device that projects a video 

signal from computer, home theater system etc.  

● Movie projector, a device that projects moving pictures from a filmstrip Slide 

projector.  

 

Networks 

Computer Network: 

● A network consists of two or more computers that are linked in order to share 

resources (such as printers and CDs), exchange files, or allow electronic 

communications. In other words, a set of devices often mentioned as nodes 

connected by media link is called a Network. 

● The computers on a network may be linked through cables, telephone lines, 

radio waves, satellites, or infrared light beams and other set of devices used in 
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establishing a connection are switches, modems, routers etc. These links 

connecting the devices are called Communication channels.  

● A node can be a device which is capable of sending or receiving data generated 

by other nodes on the network like a computer, printer etc. The best example 

of computer network is Internet. 

● A network must be able to meet certain criteria that are – Performance, 

Reliability, Scalability. 

● The performance of the computer network can be measured in the following 

ways:  

⮚ Transit time: It is the time taken to travel a message from one device to 

another. 

⮚ Response time: It is defined as the time elapsed between enquiry and 

response. 

● The other ways to measure performance are: Efficiency of software, Number of 

users, Capability of connected hardware 

Basic Communication Model 

A Communication model is used to exchange data between two parties. For 

example: communication between a computer, server and telephone (through 

modem). 

 

● Source: Data to be transmitted is generated by this device, example: 

telephones, personal computers etc. 
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● Transmitter: The data generated by the source system is not directly 

transmitted in the form its generated. The transmitter transforms and encodes 

the data in such a form to produce electromagnetic waves or signals. 

● Transmission System: A transmission system can be a single transmission line 

or a complex network connecting source and destination. 

● Receiver: Receiver accepts the signal from the transmission system and 

converts it into a form which is easily managed by the destination device. 

● Destination: Destination receives the incoming data from the receiver. 

A computer network can be categorized by their size. A computer network is 
mainly of four types: 

 
 

o LAN (Local Area Network) 

o MAN (Metropolitan Area Network) 

o WAN (Wide Area Network) 

 

1. LAN or Local Area Network links network devices in such a way that personal 
computer and workstations can share data, tools and programs. Data transmits 
at a very fast rate as the number of computers linked are limited. LAN’s cover a 
smaller geographical area and are privately owned. One can use it for an office 
building, home, hospital, schools, etc. LAN is easy to design and maintain. 

A Communication medium used for LAN has twisted pair cables and coaxial 
cables. It covers a short distance, and so the error and noise are minimized. LAN 
can be configured in the ring, bus and star topology. The ring topology is 
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prevalent in the Token Ring LANs of IBM and bus is widespread in Token Bus and 
Ethernet LANs. 

 

It is a broadcast network where the message is sent to all the connected hosts as 
all the host share the same transmission medium (wire). Broadcasting can be 
done in two ways statically and dynamically. In the static technique, the hosts are 
provided with a definite time slice for transmitting the information. While in 
the dynamic method the hosts can flexibly send the frame at any particular time. 

2. MAN or Metropolitan Area Network covers a larger area than that of a LAN 
and smaller area as compared to WAN. It connects two or more computers that 
are apart but resides in the same or different cities. It covers a large 
geographical area and may serve as an ISP (Internet Service Provider). It’s hard 
to design and maintain a Metropolitan Area Network. 

 

It is costly and may or may not be owned by a single organization. The data 
transfer rate of MAN is moderate. 

MAN can be categorized into two types: DQDB and SMDS. 



Unit – I  EIT 

ST Joseph’s Degree & PG College  32 
 

● DQDB (Distributed Queue Dual Bus): It is considered as a dual bus 
configuration refers that each host in the network would be linked to the 
two backbone network lines. 

● SMDS (Switched Multimegabit Data Services): SMDS connects different 
LANs and permits packets to transfer to any other LAN on the SMDS. It is a 
high-speed MAN which uses packet switching as a datagram service. 

3. WAN or Wide Area Network is a computer network that spans over a large 
geographical area. A WAN could be a connection of LAN connecting to other 
LAN’s via telephone lines and radio waves. 

Wide Area Network may or may not be privately owned. A Communication 
medium used for wide area network is PSTN or Satellite Link. Due to long distance 
transmission, the noise and error tend to be more in WAN. Propagation delay is 
one of the biggest problems faced here.

 

Unlike LAN, WAN uses switching that allows multiple computers to connect with 
several switches instead of connecting with each other. It also uses the store-and-
forward concept to transmit packets, where packets are stored in a buffer on a 
temporary basis then forwarded to the destination by following the predefined 
path. 

 

NETWORK TOPOLOGY: 

Each computer or device in a network is called a node. The geometrical 

arrangement of computer resources, remote device and communication facilities 

are known as network topology. 

 A network topology can be made in one of the five different topologies. 
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1. Bus network 

2. Ring Network 

3. Star Network 

4. Tree Network  

5. Mesh Network 

1. BUS Topology 

Bus topology is a network type in which every computer and network device is 

connected to single cable. When it has exactly two endpoints, then it is 

called Linear Bus topology. This topology is commonly used along with the local 

area networks. 

 

Features of Bus Topology 

1. It transmits data only in one direction. 

2. Every device is connected to a single cable 

Advantages of Bus Topology 

1. It is cost effective. 

2. Cable required is least compared to other network topology. 

3. Used in small networks. 

4. It is easy to understand. 

5. Easy to expand joining two cables together. 

Disadvantages of Bus Topology 

1. Cables fails then whole network fails. 
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2. If network traffic is heavy or nodes are more the performance of the network 

decreases. 

3. Cable has a limited length. 

4. It is slower than the ring topology. 

2.RING Topology 

It is called ring topology because it forms a ring as each computer is connected to 
another computer, with the last one connected to the first. Exactly two neighbors 
for each device.  

 

Features of Ring Topology 

1. One station is known as monitor station which takes all the responsibility to 

perform the operations. To transmit the data, station has to hold the token. 

After the transmission is done, the token is to be released for other stations to 

use. When no station is transmitting the data, then the token will circulate in 

the ring. 

2. The transmission is unidirectional, but it can be made bidirectional by having 2 

connections between each Network Node, it is called Dual Ring Topology. 
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3. In Dual Ring Topology, two ring networks are formed, and data flow is in 

opposite direction in them. Also, if one ring fails, the second ring can act as a 

backup, to keep the network up. 

4. Data is transferred in a sequential manner that is bit by bit. Data transmitted, 

has to pass through each node of the network, till the destination node. 

Advantages of this topology: 
● The possibility of collision is minimum in this type of topology. 
● Cheap to install and expand. 

 
Problems with this topology: 
● Troubleshooting is difficult in this topology. 
● Addition of stations in between or removal of stations can disturb the whole 

topology. 

3.STAR Topology 

In star topology, all the devices are connected to a single hub through a cable. This 
hub is the central node and all others nodes are connected to the central node. The 
hub can be passive in nature i.e. not intelligent hub such as broadcasting devices, 
at the same time the hub can be intelligent known as active hubs. Active hubs have 
repeaters in them. It can be used with twisted pair, Optical Fibre or coaxial cable. 

 

Advantages of Star Topology 
1. Fast performance with few nodes and low network traffic. 
2. Hub can be upgraded easily. 
3. Easy to troubleshoot and easy to setup and modify. 
4. Only that node is affected which has failed, rest of the nodes can work 

smoothly. 
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Disadvantages of Star Topology 

1. Cost of installation is high, Expensive to use. 
2. If the hub fails, then the whole network is stopped because all the nodes 

depend on the hub. 
3. Performance is based on the hub that is it depends on its capacity 

4.MESH Topology 

It is a point-to-point connection to other nodes or devices. All the network nodes 
are connected to each other. Mesh has n(n-1)/2 physical channels to link n devices. 

There are two techniques to transmit data over the Mesh topology, they are: 

Routing: In routing, the nodes have a routing logic, as per the network 
requirements. Like routing logic to direct the data to reach the destination using 
the shortest distance. Or, routing logic which has information about the broken 
links, and it avoids those node etc. We can even have routing logic, to re-configure 
the failed nodes. 

Flooding: In flooding, the same data is transmitted to all the network nodes, hence 
no routing logic is required. The network is robust, and the its very unlikely to lose 
the data. But it leads to unwanted load over the network. 

 

Types of Mesh Topology 

1. Partial Mesh Topology: In this topology some of the systems are connected in 

the same fashion as mesh topology but some devices are only connected to 

two or three devices. 

2. Full Mesh Topology: Each and every nodes or devices are connected to each 

other. 
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Advantages of mesh topology: 
● It is robust. 
● Fault is diagnosed easily. Data is reliable because data is transferred among 

the devices through dedicated channels or links. 
● Provides security and privacy. 

Disadvantages of mesh topology: 
● Installation and configuration is difficult. 
● Cost of cables are high as bulk wiring is required, hence suitable for less 

number of devices. 
● Cost of maintenance is high. 

 

5.TREE Topology 

It has a root node and all other nodes are connected to it forming a hierarchy. It is 
also called hierarchical topology. It should at least have three levels to the 
hierarchy. 

 

Features of Tree Topology 

1. Ideal if workstations are located in groups. 

2. Used in Wide Area Network. 

Advantages of Tree Topology 

1. Extension of bus and star topologies. 

2. Expansion of nodes is possible and easy. 

3. Easily managed and maintained. 

4. Error detection is easily done. 



Unit – I  EIT 

ST Joseph’s Degree & PG College  38 
 

Disadvantages of Tree Topology 

1. Heavily cabled. 

2. Costly. 

3. If more nodes are added maintenance is difficult. 

4. Central hub fails, network fails. 

 

6.HYBRID Topology 

It is two different types of topologies which is a mixture of two or more topologies. 

For example, if in an office in one department ring topology is used and in another 

star topology is used, connecting these topologies will result in Hybrid Topology 

(ring topology and star topology). This is a scalable topology which can be expanded 

easily. It is reliable one but at the same it is a costly topology. It Inherits the 

advantages and disadvantages of the topologies included 

Advantages of Hybrid Topology 

1. Reliable as Error detecting and troubleshooting is easy. 

2. Effective. 

3. Scalable as size can be increased easily. 

4. Flexible. 

Disadvantages of Hybrid Topology 

1. Complex in design. 

2. Costly. 
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MS WORD: Features of Word Processing-Advantages and Applications of Word 

Processing-Parts of Word Application Window- Toolbars, Creating, Saving and Closing a 

Document, Opening and Editing a Document- Paragraph Formatting, Applying Headers, 

Footers and Page Breaks- Auto Correct- Spelling and Grammar Checking –Graphics, 

Templates and Wizards – Mail Merge- Meaning, Purpose and Advantages- Creating 

Merged Letters, Mailing Labels. –Working with Tables, -Format Painter 

 

MS ACCESS: Data, Information, Database, File, Record, Fields - Features, advantages, 

and limitations of MS Access – Application of MS Access - Parts of MS Access window 

– Tables, Forms, Queries and Reports – Data validity checks  

 

Microsoft Office 

About MS-OFFICE 

 Microsoft Office is a suite of desktop productivity applications that is designed 

specifically by Microsoft for business use. It is a proprietary product of Microsoft 

Corporation and was first released in 1990. MS Office helps simplify basic office tasks and 

improve work productivity. Each application is designed to address specific tasks, such as 

word processing, data management, making presentations and organizing emails. 

Microsoft has developed multiple versions of Office that can be supported by different 

operating systems, including Windows, Linux, and macOS. Microsoft Office is also offered 

in 35 different languages.  

Here is a brief explanation of each of the different apps of Microsoft Office and what you 

can use them for: 

• Microsoft Word: is a word processor that lets users make and edit text documents, 

such as reports, letters, and résumés and run spell-checks on writing 

https://softwarekeep.com/office-apps/word
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• Microsoft Excel: is an electronic spreadsheet program that helps you store, 

organize and manipulate data by creating simple to complex spreadsheets 

• Microsoft PowerPoint: allows you to visually display information, using anything 

from basic slideshows to professional multimedia presentations 

• Microsoft Outlook: is a personal information manager mainly used for emails but 

that can also be used to store calendars and contact information, manage tasks as 

well as organize meetings 

• Microsoft Access: is a database management system that allows you to link and 

use data from other sources, manipulate the data you’ve gathered in different 

ways, as well as create simple business applications 

• Microsoft Publisher: is a graphic design app that gives users creating material for 

marketing or publications more options in the layout and design of their document.  

• Microsoft OneNote: is a digital alternative to a paper notebook that allows you to 

create, organize and share your notes easily 

 

Microsoft Word 

 

Word processor is a computer program or software that is designed to help us create, 

edit, save, and print documents or text files. Microsoft Word is a powerful windows-

oriented word processor that lets you prepare a variety of documents. If necessary you 

can easily correct errors by adding or deleting words, sentences, paragraphs or pages. 

After you have created and corrected your text, you can print it and store it on hard disk 

for further reference. 

 

Features of MS-Word 

➢ The Ribbon system: Cascading menu options and the many toolbars have been 

replaced by the tabbed Ribbon system. The tabs contain the same commands as the 

https://www.techopedia.com/definition/13140/microsoft-publisher


EIT Notes  Unit – II: MS-Word 

3 
 

menus in earlier versions; however, related command buttons are organized together 

in groups, which often make it easier to accomplish tasks in fewer steps.  

 
 

➢ Quick Styles: Earlier versions of Word include Styles, but in Word 2007 these are 

extremely easy to access and use. Quick Styles are combinations of formatting and 

heading options that are displayed in the Styles gallery on the Home tab. You can 

choose a Quick Styles group from the Style gallery that formats text in a cohesive and 

attractive manner. 

 

➢ Themes: Themes, like Styles, are a tool used to produce professional-look to the 

documents. A theme is a set of formatting choices that includes colors, heading, and 

body text fonts, as well as theme effects like lines and fill effects. When used in 

conjunction, Styles and Themes are powerful tools to producing powerful documents. 

 

➢ Spell Checking and Grammar: Word includes the capability to check the spelling and 

grammar in a document. Only word has a spell checker and correction tool which not 

only checks but can also correct the errors.  There is built-in dictionary named custom 

dictionary having the custom.dic file Spell checker also gives us suggestions about the 

different words if any error occurs in the document. 

 

➢ Thesaurus: Thesaurus is used to type an alternate word in place of any word typed in 

the document   It will display the meanings of the word actually or synonyms of the 

word. 

 

➢ Print Preview:  We can print a document, table, chart or any text or graphics material 

from the document file.  Before taking print, we should take the view of our printed 

document using the PRINT PREVIEW. 
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➢ Tables:  Microsoft Word has provided a facility to create tables automatically.  It is very 

powerful and flexible facility provided by the word to us.  We can create a table having 

any number of rows and columns having different size of cells.  We can format the text 

within the cells also. 

 

➢ Border and Shading: Border and Shading can be done to a paragraph for enhancing its 

appearance or to the doted and dimmed line table to convert these into solid line 

having gridlines.  We can apply shadings to the paragraphs by this option. 

 

➢ Templates and Wizard:  Templates and wizards make the formatting of the business 

letters/ documents to be sent in daily routine to the different business firms much 

faster and easy. 

 

➢ Mail merging the files:  The term mail merge is typically used to describe the process 

of merging some form of address database with a form of letters to create a group of 

individual letters.  It is a good feature of the MS-Word. 

 

➢ Exporting Files:  Exporting files means to share format of Ms-Word documents with 

other application program like Power Point or Access etc., by using linking and 

embedding features available in any office application, we can easily include 

information from a document created in another application. 

 

➢ Importing Files:  Importing means linking a file from other application. i.e., it is to pick 

or call the file from an application other than MS-Word. The import process is identical 

to the export process. 

 

➢ Formatting page, paragraphs, sections, Indent:  Formatting the Page means to set the 

margins (left, right, top, bottom, header, footer and gutter). 

 

➢ Creating Lists and Numbers:  MS-Word provides us the facility to easily number our 

lines, paragraphs or mark and put the bullets at the beginning of paragraph or 

beginning of every line. Here lists are the different bullets, which are used during the 
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description of various lists of different objects or lines or steps.  We can also set 

numbers to different lines, different headings automatically by setting the Numbering 

headings. 

 

➢ Positioning and Viewing Text:  MS-Word provides a number of document views.  User 

can quickly change the way of display using the view menu.  Different views of 

information can be seen by using the Normal, outline, page layout buttons which are 

at the left corner of the horizontal scroll bar. 

 

➢ Inserting date & Time:  While working in any document, many a times one needs to 

insert date into the document.  So by using the word facility, we can insert the current 

system date & Time. 

 

➢ Setting Tabs:  During typing we will try to use spacebar for alignment of column which 

is time consuming or to set user defined Tab stops we can use this TABS option. User 

can define tab stops with the help of ruler bar and mouse or by suing the tab dialog 

box.  Thus tab settings or tabs are of following 4 types which can be changed by clicking 

the tab button.  1. Left    2. Right    3. Decimal   4. Center. 

 

➢ Labels & Envelopes:  MS-Word automates the process of creating envelopes, enabling 

us to specify the envelope type, print options and other variables.  Word allows us to 

specify the type of label having size, number per page etc., and then creates a main 

document consisting of page label.  Each label cell contains the fields to insert the 

address information. 

 

Advantages and Applications: 

1. As compared to a typewriter that has been replaced by use of word processing 

software we are able to prepare documents with a very wide range of font types 

and sizes. This includes basic fonts plus variations such as bold and italics fonts. In 

addition, we can print many different types of symbols. Also there are additional 

facilities like subscript and superscript. 

2. Easy formatting of document - for example centering and right justification. 

3. Facilities for bulleting and numbering of list. 
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4. Formatting for different sizes of papers and margin widths. 

5. Automatic formatting of different sections of a document including section and 

page numbering. 

6. Ability to make correction easily, and before a document is printed. Facilities like 

spell check further improve the capability to locate errors and make corrections. 

7. Facilities like mail merge allow a document created once to be used to create 

multiple documents with same part of the document changed. The cut/copy and 

paste facility makes it easier to copy from one document to another, or to make a 

new document by making changes in copy of another one. 

8. Different type of data - such as diagrams and pictured can be easily inserted 

between texts. 

 

Parts of MS Word Window: 

When you launch MS Word 2007, its program window appears on screen. A screenshot 

of the window is shown below with the screen elements labeled. This introduces 

elements in brief. 
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1. Title Bar 

The title bar shows the name of the document on screen. When a new document is 

started, Word 2007 gives it a generic name like ‘Document 1’ and this is displayed on 

the title bar. When you save the document with a name, the generic name on the title 

bar is replaced by the given name. 

 

2. Quick Access Toolbar 

 Located in the top left corner of the Word 2007 window, the Quick Access Toolbar 

contains some of the most frequently used commands like Save, Undo, Redo. You can 

add more commands to the Quick Access Toolbar as per your need. This toolbar helps 

you to perform Word tasks speedily by providing one-click access to oft used 

commands.  

 

3. Window Controls 

 These are a set of three buttons in the top right corner of the program window.  

http://4.bp.blogspot.com/-RF7v_-DheWc/UWuu435LqgI/AAAAAAAABGI/fnO8RgEDdSk/s1600/01-Word+2007+Interface.png
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• The right button displaying an “x” is the Close button. On clicking, this button 

closes the current document but not the Word programme. 

• The left button is the Minimize button which minimizes the program window to 

the taskbar. 

• The middle button, sporting a rectangle, is the Maximize button, which, on 

clicking, maximizes the Word 2007 window and the button image changes to a 

pair of rectangles. Another click restores the program window to its previous size 

and the button image to a single rectangle. 

4. Ribbon  

 You can think of the Ribbon as a collection of seven horizontal tabbed toolbars 

arranged on top of each other. These toolbars are accessed through their tabs. The 

toolbars have command buttons, menus and input boxes arranged in groups. Some 

groups have dialog launchers (represented by a downward pointing arrow) which, when 

clicked, display a dialog box related to that group.  

 

 You may minimize the ribbon by clicking the 'Customize Quick Access Toolbar' 

button located to the right of the 'Quick access Toolbar' and choosing 'Minimize the 

Ribbon' from the drop-down menu. The Ribbon can also be minimized by double clicking 

the active tab; clicking any tab of the minimized Ribbon will redisplay it once again. 

 

5.Office Button 

Clicking 'Office' button reveals a drop-down menu showing commands for file 

operations. These commands are described below in brief.  

• New: When you click this button, the 'New Document' window comes up displaying 

three panes. The first pane shows a list of templates types, the second pane shows 

the templates available for the template type selected in the first pane and the 

third pane shows a preview of the template selected in second pane. You can start 

a new document based on a template selected from amongst these. By default, the 

blank document template is chosen. Clicking the Create button starts a new 

document based on the selected template. Notice that Word 2007 offers a wide 

variety of templates from the Microsoft Office Online. 
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• Open: Starts the Open dialog where you can navigate to your documents folder, 

select an existing (i.e. previously saved) document and open it in Word window. 

 

• Save: Clicking Save button saves the current document if it has been given a name 

and saved earlier, otherwise it launches the Save As dialog. 

 

• Save As: Opens the Save As dialog. Here you can assign a name to a new 

document and save it. You may also rename a document saved earlier and save it 

with the new name. 

 

• Print: This command is used for printing the current document.   

 

• Send: You may use this command to email a document or to fax it via internet. 

 

• Publish: This command allows you to create a blog post and publish it. 

 

• Close: You can close the current document using this button. However, the Word 

2007 program keeps running. 

 

• Word Options: Opens the Word Options Dialog where you can choose your 

preferred settings for display, proofing, saving, language, etc. It also provides 

facility for customizing the Ribbon and the Quick Access Toolbar. 

 

• Exit Word: Clicking this option closes the Word 2007 programme together with all 

open documents. 

6.Help Button 

 Located below the Window Controls in the top right corner of Word window, this 

button brings up the Word Help window.  

 

7.Rulers 

 The horizontal ruler is used to set tabs and indent text. You may use the vertical 

ruler to set vertical location of text in the document. If the rulers are not visible, click the 
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View Ruler button immediately below the Ribbon on the extreme right.  

 

 The rulers show measurements in inches or centimeters, depending on the units 

of measure specified in Word Options 

 

8.Status Bar 

 On the left hand side, the status bar displays document information such as the 

current page number and total number of pages, word count, language, proofing error 

notification, etc. You can customize the information display by right clicking the status 

bar and making selections out of the context menu that pops up.  

 

9.View Buttons  

These buttons allow you to use five different document views:  

• Print Layout View: This view shows the document as it will look when it is printed. 

• Full Screen Reading View: This view shows the document on full screen to make 

reading your document more comfortable. 

• Web Layout View: Web Layout view enables you to see your document as it 

would appear in a browser such as Firefox or Internet Explorer. 

• Outline View: Outline view displays the document in outline form in which 

headings could be displayed without the text. When you move a heading, the 

accompanying text will move with it. 

• Draft View: This is the most frequently used view for editing your document. 

 

10.Zoom Tools 

The Zoom slider lets you zoom out or zoom in the current document. The zoom range is 

from 10% to 500%. The current zoom level is displayed on the taskbar immediately left 

of the slider. Clicking the zoom level opens the Zoom dialog where you can specify the 

desired zoom level. 

 

11.Vertical & Horizontal Scroll Bars  

The vertical scroll bar is located at the extreme right of the Word 2007 window while 

the horizontal scroll bar is at the bottom of the window just above the status bar. 
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Vertical scroll bar is always visible while the horizontal scroll bar appears only when the 

document width exceeds the screen width.  

 

 The scroll bars let you scroll the document up-down vertically or left-right 

horizontally. To scroll, you need to click and drag the scroll box showing three 

vertical/horizontal lines. The document moves in a direction opposite to the movement 

of the scroll box. 

 

12.Text Area 

Framed between the rulers and the scroll bars is a large area looking like a blank sheet 

of paper. This is the text area where you type the text of the document. You will see a 

blinking vertical line in the top left corner. This is the Cursor. The typed characters 

appear at its location. As a character appears at its location, the cursor moves to its 

immediate right. 

 

Creating, Saving and Closing a document: 

 

• Creating 

To create a new file based on the default Template, click the New Button on the standard 

toolbar or press Ctrl+N or Alt+F+N word will open a new document named Document 

(Document1, Document2, Document3, etc.).  

To Create a new file based on a different template: 

1. Choose File ->New to display the new dialog box for the application select any 

template you want to capture in your current File. For example, Letters and faxes 

etc.  

 

• Saving a File 

The first time you save a file, you assign it a name and choose the folder in which to save 

it. Thereafter, when you save the file, the application uses that name and folder and does 

not prompt you for changes-unless you decide to save the file under a different name. In 

that case, you need to use the File -> Save As command rather the File-> save.  

 

Saving a File for the First Time 
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To save a file for the first time: 

1. Choose File-> Save to display the save as dialog box. (The dialog boxes in the 

different applications have slightly different names. Instead of choosing File->Save, 

you can click the save button on the Standard Toolbar or press either Shift+F12 or 

Ctrl+S.  

2. In the File Name Text Box, enter a name for your file.  

3. With windows ’95 and windows- NT’ long file names, you can enter through and 

descriptive name-up to 255 characters, including the path to the file.  

4. Click the Save Button to save the file.  

 

• Saving a File Again:  

To save a file that you’ve saved before, choose the save command by using one of the 

methods given in the previous section: Click the Save button on the standard toolbar or 

choose File-> Save or Press Ctrl+S, Shift+F12, or Alt+Shift_F2. The application will save 

the file without consulting you about the location or file name. 

• Opening a File 

To open a file in the current Application: 

1. Click the open button on the standard toolbar, or choose File-> Open, Or Press  

2. Ctrl+O to display the open Dialog Box.  

3. If you’re already in the right folder, proceed Step 3, if not, use the Look in Drop 

down  

4. List to navigate to the folder holding the file you want to open. Move through the  

folder using standard navigation: Click the Up One Level button or press the Back  

Space Key in Look in) to move Up One Level of folders or double-click a folder to  

move down through it.  

5. Choose the file to open, and then click the open button.  

 

Opening and Editing a document 

Entering Text  

 Word displays a blinking vertical line in the work area. This is the cursor or 

insertion point, and it identifies the location in the document. Where text will be 

inserted and where certain editing actions will occur. To enter text, simply type it on the 
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keyboard. You shouldn’t press Enter at the end of a line. Word will automatically wrap 

the text to a new. 

To Open and Existing File  

1. Click File, Open or click on the Open Button on the standard toolbar.  

2. Select the drive or the folder where the file is stored from look in drop-down list, if 

necessary.  

3. Click its name in the file list or type its name into the File Name list box.  

4. Press Enter or the Open button. Or you can double click the name.  

 

Moving and copying text  

You may want to move or copy a text to another part of the document.  

To Move or Copy text  

1. Select the text to be moved/copied  

2. To copy the text, click Edit, Copy; or click the Copy button on the standard toolbar; 

or press Ctrl + C. to move the text, click Edit, cut; or click the Cut button on the 

standard toolbar; or press Ctrl + X.  

3. Move the cursor to the location where you want the text moved or copied.  

4. Click Edit, Paste; or click the Paste button on the standard toolbar; or Press Ctrl + V  

 

TEMPLATES 

A template is a predesigned document you can use to create new documents with the 

same formatting. With a template, many of the more important document design 

decisions such as margin size, font style and size, and spacing are predetermined. 

 

TO INSERT A TEMPLATE: 

• Click the Microsoft Office button. 

• Select New. The New Document dialog box 

appears. 

• Select Installed Templates to choose a template 

on your computer. 

• Review the available templates. 

• Left-click a template to select it. 



EIT Notes  Unit – II: MS-Word 

14 
 

• Click Create, and the template opens in a new 

window. 

 
 

TO INSERT TEXT INTO A TEMPLATE: 

 

• Click near the text you want to replace. The text 

will appear 

• Enter text. The placeholder text will disappear. 

TO CHANGE PREFILLED INFORMATION: 

• Select the Microsoft Office button. 

• Click the Word Options button at the bottom of the menu. The Word Options 

dialog box appears. 

• Enter the user name and/or initials in the Popular section. 

• Click OK. 

 

 
 

Formatting Paragraphs  
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When we type information into Microsoft Word, each time we press the Enter key 

Word creates a new paragraph. We can format paragraphs. For example, we can indent 

the first line of a paragraph, set the amount of space that separates paragraphs, and can 

align a paragraph left, right, center, or flush with both margins. Styles are a set of formats 

we can quickly apply to a paragraph. For example, by applying a style, we can set the font, 

set the font size, and align a paragraph all at once. When we are formatting a paragraph, 

we do not need to select the entire paragraph. Placing the cursor anywhere in the 

paragraph enables us to format it 

 

Line Spacing 

Line spacing sets the amount of space between lines within a paragraph. The 

spacing for each line is set to accommodate the largest font on that line. If the lines 

include smaller fonts, there will appear to be extra space between lines where the smaller 

fonts are located. At 1.5, the line spacing is set to one-and-a-half times the single-space 

amount. At 2.0, the line spacing is set to two times the single-space amount (double 

space). 

 
 

1. Place your cursor anywhere in the paragraph  

2. Choose the Home tab. 

3. Click the Line Spacing button  in the Paragraph group. A menu of options 

appears. 

4. Click 2.0 to give double-space between the lines of paragraph. 

 

Indent Paragraphs 
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Indentation allows us to indent paragraph from the left and/or right margin. 

Microsoft Word gives us choice of several types of alignments.  

• Left-aligned text is flush with the left margin of our document and is the default 

setting.  

• Right-aligned text is flush with the right margin of our document  

• centered text is centered between the left and right margins, 

• Justified text is flush with both the left and right margins. 

• Hanging indent, this feature indents the first line of the paragraph from the 

margin by the amount specified in the Left field. The amount in the Left field 

plus the amount specified in the by Field indent all subsequent lines. 

Styling Set 

• When working with Word, we can use styles to quickly format our documents. 

• A style is a set of formats consisting of fonts, font colors, font sizes, and 

paragraph formats. Word supplies us with predesigned style sets that contain 

styles for titles, subtitles, quotes, headings, lists and more 

 
 

Adding Bullets and Numbers 

If you have lists of data, we can easily create bullet or number lists of items using MS 

word. To add bullets or numbers 

1. Type the following list as shown: 

Apple  

Orange  

Grape  
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2. Select the words you just typed. 

3. Choose the Home tab. 

4. In the Paragraph group, click the down arrow next to the Bullets button . Or 

number button Library appears. 

5. Click to select the type of bullet or number you want to use. Word adds it to your 

list. 

• Apple  

• Orange 

• Grape  

To remove the bullets or numbering: 

1. Select the list. 

2. Choose the Home tab. 

3. In the Paragraph group, click the down arrow next to the Bullet or number icon. 

The dialog box appears. 

4. Click None. Word removes the bullets or numbering from your list. 

 Orientation 

Before we print our document, we may want to change the orientation of our 

pages. There are two orientations: portrait and landscape 

• Portrait, the shortest edge of the paper becomes the top of the page. It is the 

default option 

• Landscape, the longest edge of the paper becomes the top of the page 

 
 

Borders and Shading: 

  We can change the appearance of page boarder by selecting the page borders 

option from page layout tab, and selecting the different page boarder with shades to the 

entire document or a selected paragraph. Steps to set the Boarders and Shades: 
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1. First select the required document or text to apply the boarder & shading. 

2. Select the page Borders option from the page layout tab. 

3. Then boarder & shading dialog box is displayed with two tabs one is boarder, second 

one is shading with preview facility. 

4. Select the boarder & Shading, then click OK button. 

 

Insert Page Breaks: 

 Page break is a point where we wish our page to end.  Beyond that point nothing 

can be written on that page. It can be just after entering two lines or 10 lines. This option 

helps if on a page you only want certain amount of text, like just a heading or simple 

message. You do not want other content getting on that page, once you modify 

(add/delete) other pages in the document. 

 

 
 

• Place your cursor before the D in "Displaced Homemakers" 

• Choose the Insert tab. 

• Click Page Break. Word places a page break in your document. 

• To delete a page break, you select the page break and then press the Delete key 

 

Inserting Objects: 

 

Insert a WordArt Object 

To insert a WordArt object, follow these steps:  

1. Click on Insert tab, select Text group, in that click on word art icon 
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o Or click the WordArt button on the Drawing toolbar. 

o Or click Insert WordArt on the WordArt toolbar. 

2. In the WordArt Gallery dialog box, double-click the style that you want. 

3. In the Edit WordArt Text dialog box, type your text and select the font and size 

that you want.  

4. Click Bold or Italic to make all the text bold or italic. 

In the Edit WordArt Text dialog box, click OK. 

 

Inserting  Picture/ Clipart /Videos 

1. On the Insert tab, in the Illustrations group, click Clip Art/Picture/ Videos. 

 
2. In the Clip Art task pane, in the Search for text box, type a word or phrase that 

 describes the clip art that you want, or type in    all or some of the file name of the 

 clip art. 

3. To modify your search, do one or both of the following: 

• To expand your search to include clip art on the Web, click the Include Office.com 

content checkbox. 

• To limit the search results to a specific media type, click the arrow in the Results 

should be box and select the check box next to Illustrations, Photographs, 

Videos, or Audio. 

4. Click Go. 

5. In the list of results, click the clip art to insert it. 

 

Header and Footers: 

• We can make our document look professional and polished by using header and 

footer sections.  

• The header is a section of the document that appears in the top margin, while 

the footer is a section of the document that appears in the bottom margin.  

• Headers and footers generally contain information such as page number, date, and 

document name.  

To Insert a Header& Footer: 
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• Select the Insert tab. 

• Click either the Header or Footer command. A menu appears with a list of built-in 

options you can use. 

• Left-click one of the built-in options, and it will appear in the document. 

• The Design tab with Header and Footer tools is active. 

 
• We have many header and footer options to design our document. From the 

Header and Footer Tools Design tab, we can see all of our design options.  

 

Spelling and Grammar Check: 

Word checks your spelling and grammar as you type. Spelling errors display with a 

red wavy line under the word. Grammar errors display with a green wavy line under the 

error. In Word 2007, you can use the Review tab's Spelling & Grammar button to initiate 

a spell and grammar check of your document. 

 
 

Type the following exactly as shown. Include all errors.  

Open the door for Mayrala. She is a teacher from the town of Ridgemont. 

• Select: "Open thr door for Mayrala. She is a teacher from the town of 

Ridgemont." 

• Choose the Review tab. 

• Click the Spelling & Grammar button. The Spelling and Grammar dialog box 

appears. 
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• "The" is misspelled, so it is highlighted on the screen and noted in the Not in 

Dictionary box. Word suggests correct spellings. These suggestions are found in the 

Suggestions box. 

• Click "the" in the Suggestions box. 

• Click Change.  

 

Note: If the word is misspelled in several places, click Change All to correct all 

misspellings. 

• The name "Mayrala" is not in the dictionary, but it is correct. Click Ignore Once to 

leave "Mayrala" in the document with its current spelling. 

 

Note: If a word appears in several places in the document, click Ignore All so you are 

not prompted to correct the spelling for each occurrence. 

 

• "Ridgemont" is not found in the dictionary. If you frequently use a word not found 

in the dictionary, you might want to add that word to the dictionary by clicking the 

Add to Dictionary button. Word will then recognize the word the next time it 

appears. Click Add to Dictionary. 

• The following should appear on your screen: "Word finished checking the selection. 

Do you want to continue checking the remainder of the document?" 

• Click No. If you wanted Word to spell-check the entire document, you would have 

clicked Yes. 
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Thesaurus 

 Thesaurus is used to type an alternate word in place of any word typed in the 

document   it will display the meanings of the word actually or synonyms of the word. 

1. Select the word for finding the different meanings and more information about that 

word. 

2. Select the Thesaurus option from the review tab or simply press Shift + F7, 

combination key from the keyboard. 

3. The thesaurus dialog box will be displayed with list of options like meaning of the word, 

in the meaning box, synonyms in the synonyms box, replace, look up...etc. 

4. Select the appropriate option, and then we automatically exit from the Thesaurus 

option. 

 

Find and Replace: 

 If we need to find a particular word or phrase in your document, we can use the 

Find command. This command is especially useful when you are working with large files. 

If we want to search the entire document, simply execute the Find command. We can 

also limit our search by selecting a particular area and then execute the Find command. 

 After we find the word or phrase we are searching for, we can replace it with new 

text by executing the Replace command. 

 

STEPS TO FINDAND REPLACE 

• Click ‘Home’ tab, then click ‘Replace’ button in the ‘Editing’ group. The ‘Find 

&Replace’ dialog will start with ‘Replace’ tab selected. 

• Type “rabbit” in the ‘Find what’ box. 

• Type “bunny” in the ‘Replace with’ box. 

• To check each match before replacing, click ‘Find Next’ button and wherever you 

want to make the replacement, click ‘Replace’ button. Repeat the step for each 

match. 

• To replace all occurrences of the searched word with text entered in the ‘Replace 

with’ box, just click ‘Replace All’ button. MS Word will replace “rabbit” with 

“bunny” everywhere in the document and show a message "Word has completed 

search of the document and has made 6 replacements". 
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• Click the 'OK' button on the message window to close it. 

• Close the 'Find & Replace' dialog box by clicking its 'Close' button. 

•  

 
 

 

 

Mail Merge: 

➢ The term Mail Merge is typically used to describe the process of merging some form 

of address database with a form of letter to create a group of individual letters.  It is a 

good feature of the Word.   

➢ Mail Merge is used to print letters, envelopes, mailing labels etc., suppose if we want 

to call 100 candidates for interview, then we will either type 100 letters one by one or 

just create one letter and get the 99 cyclostyled or photocopied of the created letter.  

➢ After this we will fill their name and label address on 100 letters one by one manually.  

In all the above cases it will waste of our time and processing speed also becomes 

slow.  

➢ To avoid such problem to create 100 letters manually, we use the concept of Mail 

Merging, which is an automatic process. Mail Merging is not so difficult and 

cumbersome.  

➢ In mail merging we store the label address in one file which is called data file or the 

data source file and the general body of the letter which is common for all 100 

candidates is stored in another file called master file.  So mail merging uses tow files.   

 

Mail merge list summarizes the steps involved in performing a mail merge operations: 

http://2.bp.blogspot.com/-d8UDTnYrrgQ/UXkkpNDPIhI/AAAAAAAABKs/j-UgZx_qIsw/s1600/03-Find+&+Replace+Dialog+Box+with+Replace+tab+selected.png
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(a). Create the main Letter:  It has the general body of the letter. 

(b). Create the Data Source: It has the label address of the letter. 

(c). Define Merge fields in the Main document:  User defines merge fields in the main 

document.  These fields tell the MS-Word where to insert specific data items from 

the data source. 

(d). Merge the data with Main Document:  When the main document and the data source 

are ready, we can merge two.  The result is a single document containing all the 

personalized documents with page break separating one document from another. 

(e). Print the document:  As all personalized documents are placed in a single document 

file, we can print all the documents in one operation. 

 

Types of documents we can create using Mail Merge are:  The main document in a mail 

merge operation is the one that contains the running text and graphics, which are the 

same in all the resulting documents. There are few types of main documents used in Mail 

Merge: 

1) Form Letter: - When we want to create a form letter, MS-word merges the main 

document and the data source to create a single document that contains all the 

personalized letters, with each letter in its own section. 

2) Envelopes:  MS-word automates the process of creating envelopes, enabling us to 

specify the envelope type, print options and other variables. 

3) Labels: Word allows us to specify the type of label having size, number per page. 

Etc. 

 

Write the steps to create a mail merge 

1. Select the Mailings on the Ribbon. 

2. Select the Start Mail Merge command. 

 
3. Select Step by Step Mail Merge Wizard. 

4. Choose the type of document you want to create. In this example, select Letters. 
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5. Click Next: Starting document to move to Step 2. 

6. Select Use the current document. 

7. Click Next: Select recipients to move to Step 3. 

8. Select the Type a new list button. 

9. Click Create to create a data source. The New Address List dialog box appears. 

10. Click Customize in the dialog box. The Customize Address List dialog box appears. 

11. Select any field you do not need, and click Delete. 

12. Click yes to confirm that you want to delete the field. 

13. Continue to delete any unnecessary fields. 

14. Click Add. The Add Field dialog box appears. 

15. Enter the new field name. 

16. Click OK. 

17. Continue to add any fields necessary. 

18. Click OK to close the Customize Address List dialog box. 

 

To customize the new address list: 

 
1. Enter the necessary data in the New Address List dialog box. 

2. Click New Entry to enter another record. 

3. Click Close when you have entered all of your data records. 

4. Enter the file name you want to save the data list as. 

5. Choose the location where you want to save the file. 

6. Click Save. The Mail Merge Recipients dialog box appears and displays all of the 

data records in the list. 
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7. Confirm that the data list is correct, and click OK. 

8. Write a letter in the current Word document  

9. Select the field you want to insert in the document. 

10. Click Insert. Notice that a placeholder appears where information from the data 

record will eventually appear. 

11. Repeat these steps each time you need to enter information from your data record. 

12. Click Next: Preview your letters in the task pane once you have completed your 

letter. 

13. Preview the letters to make sure the information from the data record appears 

correctly in the letter. 

14. Click Next: Complete the merge. 

15. Click Print to print the letters. 

16. Click All. 

17. Click OK in the Merge to Printer dialog box. 

18. Click OK to send the letters to the printer. 

 

Tables  

A table lets you organize information in a row and column format. The intersection of 

rows and columns is called Cell. You can have almost any number of rows and columns in 

a table. A table cell can contain text, graphics and just about everything that word 

documents can contain. The one exception is that a table can’t contain another table.  

 

Creating a Table  

To insert a new empty table at any location within your document  

 

1. Move the cursor to the document location where you want the table.  

2. Select Table, Insert →Table.  

3. In the Number of Columns and Number of Rows text box, click the arrows or enter 

the number of rows and columns the table should have.  

4. Click on AutoFormat button, to select a particular style of table from the list.  

5. In the Column Width text, select the desired width for each column (in inches). Select 

Auto in this box to have the page width evenly divided among the specified number 

of columns.  
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6. Click OK. Word creates a blank table with the cursor in the first cell.  

Note: - you can also use the Draw Table command from the Table menu. 

 

Editing and Formatting a Table  

After you create a table and enter some information, you can edit its contents and format 

its appearance to suit your needs. The following sections explain common editing 

formatting tasks you might want to perform  

 

Deleting Cells, Rows and Columns  

You can clear individual cells in a table, erasing their contents and leaving the cell blank. 

To clear the content of a cell, simply select the cell and press Delete.  

To completely remove a row or column from the table:  

1. Move the cursor to any cell in the row or column to be deleted.  

2. Select Table, Delete Cells.  

3. Select Delete Entire Row or Delete Entire Column.  

4. Click OK, and word delete the row or column.  

 

Inserting Cells, Rows and Columns  

To insert a new column or row  

1. Move the cursor to a cell to the right or where you want the new column or below 

where you want the new row.  

2. Select Table Insert Columns to insert a new blank column to the left of the selected 

column. Select Table, Insert Rows to insert a new blank row about the selected row.  

 

Merging and Splitting Cells  

1. To merge cells, select the cell to be merged and then select Table, Merge Cells.  

2. To split the cells, select the cells to be split and then select Table, Split Cells. 

Specify the number of columns and rows and click OK 

 

Changing column width and row height  

You can quickly change the width of a column with the mouse.  
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 Point at the right border of the column whose width you want changed. The mouse 

pointer changes to a pair of thin vertical lines with arrowheads pointing left and right. 

Drag the column border to the desired width.  

You can also use a dialog box to change column widths.  

1. Move the cursor to any cell in the column you want changed.  

2. Select Table, Cell Height and Width. The cell height and width dialog box appears. 

If necessary, click the Column tab to display the column options.  

3. In the Width of Column text boxes, enter the desired column width, or click the up 

and down arrows to change the setting. Note that the label identifies which column 

you are working on by number. To automatically adjust the column width to fit the 

widest cell entry, click the AutoFit button.  

4. Change the value in the Space between Columns text box to modify spacing 

between columns. Changing this setting increases or decreases the amount of 

space between the text in each cell and the cell’s left and right borders.  

5. Click Next Column or Previous Column to change the settings for other columns in 

the table.  

6. Click OK. The table changes to reflect the new column settings.  

 

Table Borders: 

Word’s default is to place a single, thin border around each cell in a table. However, you 

can modify the border or remove them altogether.  

 

To add a border to a table:  

1. Select the table cells whose borders you want to modify.  

2. Select Format, Borders and shading to display the borders and shading dialog 

box. Click the Borders tab if necessary.  

3. Select the desired border settings, using the previous box to see how your settings 

will appear.  

4. Click OK.  

 In a table with no borders, you can display non-printing gridlines on-screen 

to make it easier to work with the table. Select Table, show Gridlines to display 

gridlines. When you finish working with the table, select Table, Hide Gridlines to 

turn them off. 
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Format Painter: 

Use the Format Painter on the Home tab to quickly apply the same formatting, such as 

color, font style and size, and border style, to multiple pieces of text or graphics. The 

format painter lets you copy all of the formatting from one object and apply it to another 

one – think of it as copying and pasting for formatting. 

• Select the text or graphic that has the formatting that you want to copy. 

• If you want to copy text formatting, select a portion of a paragraph. If you want to 

copy text and paragraph formatting, select an entire paragraph, including the 

paragraph mark. 

• On the Home tab, click Format Painter. 

• The pointer changes to a paintbrush icon. 

• Use the brush to paint over a selection of text or graphics to 

apply the formatting. This only works once. To change the 

format of multiple selections in your document, you must 

first double-click Format Painter. 

• To stop formatting, press ESC. 

 

MS-Access 

Data: Data is the collection of raw facts and figures. Actually data is 

unprocessed, that is why data is called collection of raw facts and 

figures. We collect data from different resources. After collection, data 

is entered into a machine for processing. Data may be collection of 

words, numbers, pictures, or sounds etc. 

Examples of Data: 

• Student data on admission form- bundle of admission forms contains 
name, father’s name, address, photograph etc. 
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Information: Processed data is called information. When raw facts and 

figures are processed and arranged in some proper order then they 

become information. Information has proper meaning. Information is 

useful in decision-making. 

 Examples of information: 

• Student’s address labels- Stored data of students can be used to print 
address labels of students. These address labels are used to send any 
intimation / information to students at their home addresses. 
 

 Database: A database is a collection of data that is stored in a 

computer system. Databases allow their users to enter, access, 

and analyze their data quickly and easily. Database programs are 

created using a program like Microsoft Access.  

Microsoft Access is a Database Management System offered by Microsoft. A Microsoft 

Access database is made up of several components including: 

 Tables  

 Forms  

 Queries  

 Reports  

These components are called database objects. One or more of 

these objects are formed when a database is created. These 

components are stored in a single database file. 
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Table:  

• A Table is an object which stores data in Rows & Columns format. 

• A Table is usually related to other tables in the database file. 

• Each column must have Unique name 

• We can also define Primary Key in a table. 

Ex:  

 

Records 
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Data is stored in records. A record is composed of fields and contains 

all the data about one particular person, company, or item in a 

database. In other words a row in a table is called as a record. Records 

appear as rows in the database table. A record for Log ID 1201242 is 

highlighted in below Figure. 

 

Fields: 

• A field is part of a record and contains a single piece of data for 

the subject of the record.  

• In simple words, a column of a table having information in it is 

representing as a field. 

• In the database table illustrated in the below Figure, blue color 

columns - each record contains four fields: Log ID, Operator, 

Resolved, and Duration. 
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Database File: 

 It is a file which stores the entire database. The database file is 

saved to your  hard drive or other storage devices. 

 

Ex: Student.accdb is file which contains students’ data 

 

Datatypes/Field Types: 

• Datatypes are the properties of each field. Every field has one 

datatype like text,  number, date, etc. 

• Field Types:  

o Text for text and whole numbers that aren’t going to be used 

in calculations(e.g., age, phone number)  

o Date/Time for dates and time  

o Numbers for decimals and numbers that are going to be 

used in calculations, e.g. sales figures  

o Currency for money  

o Yes/No for true/false logical values, e.g. a “married” field, 

field could be logical. 

 

FEATURES OF MS ACCESS  

➢ It allows us to create the framework (forms, tables and so on) for 

storing information in a database. 

➢ Microsoft Access allows opening the table and scrolling through 

the records contained within it. 
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➢ Microsoft Access forms provide a quick and easy way to modify 

and insert records into your databases. 

➢ Microsoft Access has capabilities to answer more complex 

requests or queries. 

➢ Access queries provide the capability to combine data from 

multiple tables and place specific conditions on the data retrieved. 

➢ Access provides a user-friendly forms interface that allows users 

to enter information in a graphical form and have that 

information transparently passed to the database. 

➢ Microsoft Access provides features such as reports, macros etc. 
➢ Access Services and Web database- MS Access database retrieve 

records and display them on the browser. 

➢ Microsoft Access can also import or link directly to data stored in 

other applications and databases like Excel, XML, and Oracle etc.  

Advantages of MS ACCESS 

Here, are the pros/benefits for using MS Access application: 

• Access offers a fully functional, relational database management 

system in minutes. 

• Easy to import data from multiple sources into Access 

• You can easily customize Access according to personal and 

company needs 

• Access works well with many of the development languages that 

work on Windows OS 

• It is robust and flexible, and it can perform any challenging 

office or industrial database tasks. 
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• MS-Access allows you to link to data in its existing location and 

use it for viewing, updating, querying, and reporting. 

• Allows you to create tables, queries, forms, and reports, and 

connect with the help of Macros 

• Macros in Access is a simple programming construct with which 

you can use to add functionality to your database. 

• It can perform heterogeneous joins between various data sets 

stored across different platforms 

Disadvantages of MS-ACCESS 

• Here, are the cons for using MS Access 

• Microsoft Access is useful for small-to-medium business sectors. 

However, it is not useful for large-sized organizations 

• Lacks robustness compared to DBMS systems like MS SQL 

Server or Oracle 

• All the information from your database is saved into one file. 

This can slow down reports, queries, and forms 

• Technical limit is 255 concurrent users. However, the real-world 

limit is only 10 to 80 (depending on the type of application 

which you are using) 

• It requires a lot more learning and training compares with other 

Microsoft programs 
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PARTS OF MS ACCESS WINDOW  

On initiating Access2003, an opening window will appear (see 

below), we will now look at the basic components. 

 

The title bar. 

 

The title bar contains the name of the program. On the 

extreme right are the buttons to minimize, maximize/restore and 

close.  
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The menu bar. 

 

The menu bar contains all Access2003 commands, grouped in drop 

down menus. By clicking on Insert for example, we will see the related 

operations with the different elements that can be inserted. 

All operations can be executed from these menus. But the more regular 

things are executed more quickly from the tool bar that we will see in 

the next point. 

Every option has an underlined letter, this means that we can access 

the option directly by pressing simultaneously the Alt key and the 

underlined letter, for example, Alt+F opens File option. 

The toolbars. 

 

The toolbars contain buttons with which we can immediately access 

the most habitual commands, like Save , Open , Print , etc.  

There are options that are unavailable at certain moments. Easily 

recognised as they will have a toned down color. 

The bar we showed you is the database, more toolbars exist for 

example the task pane (this occupies the right half of the sceen), 

these are accessible according to the screen we are on as we will see 

further in the course, including learning how to define our own bars. 
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The status bar. 

 
The status bar can be found at the bottom of the screen, and contains 

indications about the state of the application, it provides varied 

information according to the screen that we are on at the time. 

Database toolbar 

 

The database toolbar presents operations that can be performed 

against different database objects, including buttons to open, design, 

delete, and create a new object. 

Table:  

• A Table is an object which stores data in Row & Column format to 

store data. 

• A Table is usually related to other tables in the database file. 

• Each column must have Unique name 

• We can also define Primary Key in a table. 

Procedure to create a TABLE in MS-Access. 

CREATING TABLES: The first step is to create a new database to store 

the data. A database is a collection of tables, forms and reports.   

1. To create a table, select the TABLE object in the database window.  

Then click on the NEW button. A new table dialog box will appears 

displaying options of Data sheet view, design view, table wizard as 

well as import and link. 
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2. To build up a table from a scratch, click on design view option and 

click ok.  A table wizard, a list of sample table structure is given. It 

provides a list of ready-made fields from which a new table can be 

built up. 

3. To design a new table the structure for a table has to be defined to 

create it. The structure consists of fields and records.  Type the field 

names, Data types and Descriptions.  A field name can have 

maximum 64 characters and have any character, number and spaces 

except for the period (.), square brackets ([]) and exclamation marks 

(!).  The data type of a field indicates the nature of data that the field 

can store. There are 8 different data types  

Data Type Meaning 

Text It can store 255 alphanumeric characters 

Number Used for calculations. 

Date/Time Used for storing date or time 

Currency Used for monetary values like amount 

Counter Is a numeric value that is automatically 

incremented with the addition of each 

record. 

Memo Used for storing detailed descriptions 

Yes/No Used for storing Boolean values 

OLE Used for storing OLE objects or graphics 
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 Use tab key to move between structure columns. 

4. After entering all the required field names and their types save the 

table by pressing Ctrl +W or Ctrl + S keys and enter the table name 

and click ok. 

5. Access then displays a “Create a Primary key ?” prompt then click 

YES. 

PRIMARY KEY: A Primary Key is that field in a table that uniquely 

identifies each record in a table. This field is called simple key or 

Primary Key. 

6. Once the table structure is created and Primary Key is set, the data 

can be entered in different fields.  

7. To enter the records into the table, select the table and click on OPEN 

button from Database window. 

8. After entering the record press Ctrl+W to save the records in the 

table. 

 

Query: 

• A query is a request for data results, and for action on data. You 

can use a query to answer a simple question, to perform 

calculations, to combine data from different tables, or even to add, 

change, or delete table data. 

• Queries answer a question by selecting and sorting and filtering 

data based on search criteria. 
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• Queries show a selection of data based on criteria (limitations) 

you provide. 

• Queries can pull from one or more related Tables and other 

Queries. 

• Types of Query can be SELECT, INSERT, UPDATE, DELETE. 

 

Procedure to create a query: 

The benefit of a database is to select the data in number of ways 

according to requirement of the user. It is possible by specifying the 

conditions to display the data.  User can perform any inquiry (Query) 

to display and edit specified information from one or more database 

tables.  The following procedure is used to create a query. 

1. Click on query object from Database window and click New button. 

2. The new query dialog box is displayed along with the five different 

options. 

3. The five different options help the user to create one of the following 

type of queries. 

a. Design view helps to select any table and add desired fields to 

a blank desktop. 

b. Simple Query Wizard helps to select tables and fields from a 

simple session of dialogs. 

c. Cross Tab Query options helps to total both rows and columns 

d. Find duplicates Query helps to find all records within a table 

having a duplicate value. 
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e. Find unmatched Query helps to find all unique records within in 

a table. 

4. Select Simple Query Wizard and click ok to display simple query 

wizard dialog box. 

5. Select a table from Table/Queries option and pick the required 

fields list using the query wizard. 

6. Click next to display next sample query wizard box. 

7. Type the query name and select finish to save the query. 

8. Click the Query View button to display Query Design view with table 

name and respective field names. 

9. In the Query Design View, use criteria option to enter user defined 

Expressions and operators used to extract the information from 

the tables. 

10. Access provides the facility of using expressions and operations. 

They include combination of operators, identifiers, constants, 

literal and functions. 

11. To run the query, select appropriate query and press RUN button. 

 

Form: 

• A form is a database object that you can use to create a user 

interface for a database application. 

• It mainly used to ease the process of data entry or editing. 

• Data in a form can be selected from one or more tables. 

• Forms can also be used to control access to data, like which fields 

or rows of data are visible to which users. 
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• Forms have a Form View. 

• Help you to display live data with easy creation of new data. 

 Forms allows the user 

❖ To enter, view and print information 

❖ Calculate totals 

❖ Display a graph 

❖ Present the data using special fonts, color and shading effects. 

 

Procedure to create a form in Ms-Access. 

1. Click on forms object from Database window and click New button. 

2. The different options help the user to create one of the forms. 

3. select the table name in “Choice the table or query box”, then pick 

auto form : columnar and click ok. 

4. Then system creates a form layout along with the record navigation 

bar at the bottom of the forms layout. 

5. Press Ctrl+w to save the form.  

6. If we want to make any modifications in the forms layout or to change 

font styles, background patters etc., we have to open the forms 

DESIGN view.  

7. To open forms design view, select the form and click on DESIGN 

button in Database Wizard. 

8. To place buttons/or any extra headings, open the form in design view 

and use the toolbox. Select the required tool and drag it into the form. 

9. Suppose any calculated columns are there in the form, we can write 

appropriate action code for each column depending on the events by 
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right clicking on the column / button and then select BUILD EVENT 

and select CODE BUILDER. Then it opens a VB code window and write 

the code for the selected object. 

 

Report: 

• A report is an object in MS Access that is designed for formatting, 

calculating and printing selected data in an organized way. 

• It contains information from tables and also information that are 

there in the report design. 

• Reports are helpful as they allow you to present all information of 

your database in an easy-to-read format. 

Procedure of creating a report: 

 A report can be created using Auto report option or using a Report 

Wizard or can be designed from scratch.  The report wizard helps to 

create basic reports that can be refined to sit the user’s requirements.  

To create a report with a Wizard,  

1. In the database Window, select the Reports Object and click New. 

2. In the NEW report dialog box select Report Wizard option. 

3. Click the table or query that contains the data on which user wants 

to base the report. This table or query is user as the default record 

source for the report but user can change the record source in the 

wizard and select fields from number of tables and queries. 
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4. Click next to design the arrangement of report. The user can add 

any grouping level. Select the required sorting field name from the 

list. 

5. Click next and report wizard asks for the sorting and summary 

information for the records. Select the required sorting field name 

from the list. 

6. Click next to design the layout of our report. There are no of layout 

options are shown and pick the layout. 

7. Click next to select the style of report. Pick the “Formal” style. 

8. Click next and Report wizard asks for the title of Report. Type the 

report title and click FINISH.  

9. Access will produce the report in a moment and is displayed on the 

screen. A report can be created automatically using Auto Report 

Tabular or Auto Report columnar options on selected table or 

query. 

 

Significance of graphs in Reports. 

A report can integrate a graph using the graph wizard. Graphs can be 

placed either on reports or forms.  It is treated as a label or text box. 

The labels and data points used in graphs are based on the fields in 

the selected tables or queries. The procedure to integrate a graph in a 

report using graph wizard is as follows: 

1. Click on Reports Object from Database Window 

2. Select the report to place a graph and click DESIGN button.  The 

report is displayed in the Design view. 
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3. Drag the bottom of the report footer bar and make room for the 

addition of graph at the end of the report. 

4. Use the Insert/chart menu selection and a chart wizard dialog box 

is displayed. 

5. Pick up the table name and click next to display the chart wizard. 

6. Select the required fields for the chart from the list of fields and 

click next. 

7. The chart wizard displays no of different chart types select any one 

click next. 

8. Drag the chart box to make it large enough to display all elements. 

9. The label names orientation, fonts, size and char type can be easily 

modified. Legends are added using the Insert / Legends menu. 

10. Save report with chart by using File / Save As. 

11. Press Ctrl + W to close the window. 

 

Data Validation Checks: 

A validation rule is one way to restrict input in a table field or a control (such as a 

text box) on a form. Validation text lets you provide a message to help users who 

input data that is not valid. 

Access provides number of ways to restrict input: 

• Data types: Every table field has a data type that restricts what users 

can enter.  

• Field properties: Some field properties restrict data input.  
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• Input masks: You can use an input mask to validate data by forcing 

users to enter values in a specific way. 

There are three types of validation rules in Access: 

1. Field Validation Rule:   You can use a field validation rule to specify 

a criterion that all valid field values must meet. You should not have to 

specify the current field as a part of the rule unless you are using the 

field in a function.  Restrictions on types of characters to be entered in 

a field may be easier to do with an Input Mask. For example, a date field 

might have a validation rule that disallows values in the past. 

Example: 

Disallow date values in the past: >=Date() 

Generally accepted email format: Is Null OR ((Like "*?@?*.?*") AND 

(Not Like "*[ ,;]*")) 

Number less than or qual to five: <=5 

Currency field can't be negative: >=0 

Restrict character length in string: Len([StringFieldName])<100 

 

 

https://support.office.com/en-us/article/control-data-entry-formats-with-input-masks-e125997a-7791-49e5-8672-4a47832de8da
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2. Record Validation Rule:  You can use a record validation rule to 

specify a condition that all valid records must satisfy. You can compare 

values across different fields using a record validation rule. For example, 

a record with two date fields might require that values of one field 

always precede values of the other field (e.g., StartDate is before 

EndDate). 

Example: 

Ensure the end date doesn't come before the start date: [End 

Date]>=[Start Date] 

Enter a required date that occurs no more than 30 days after the order 

date: [RequiredDate]<=[OrderDate]+30 

 

 

3. Validation on a form:  You can use the Validation Rule property of 

a control on a form to specify a criterion that all values input to that 

control must meet. The Validation Rule control property works like a 

field validation rule. Typically, you use a form validation rule instead of 

a field validation rule if the rule was specific only to that form and not 

to the table no matter where it was used. 
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UNIT-III  

MS POWERPOINT: Features, Advantages and Application of MS Power point – Parts of MS 

Power point window – Menus and Tool bars – Creating presentations through Auto content wizard, 

Templates and manually – slide show – saving, opening, and closing a Presentation – Inserting, 

editing, and deleting slides –Types of slides - Slide Views- Formatting –Insertion of Objects and 

Charts in slides- Custom Animation and Transition. 

 

MS POWERPOINT: 

 Microsoft PowerPoint is presentation software. It helps in quickly creating attractive and 

effective slide show presentations. Each presentation can consist of as many slides as the user 

wants. Each slide can carry text, graphics, and sound. The slides can be animated to make them 

more attractive. 

 PowerPoint lets users create and edit individual pages called slides. There can be large 

number of such slides in presentation. PowerPoint provides ready-to-use templates for slides. 

PowerPoint can be used to create: 

• Video slide show on the computer screen. 

• Color transparencies for overhead projector. 

• Black and white transparencies for overhead projector. 

• Speaker notes, remainder notes and back up information.  

• Printed handouts. 

• Presentation files 

 

FEATURES OF MS POWERPOINT: 

Power point is the most powerful instrument to present your ideas through a pictorial way. The 

following are the important features of power point. 

 

1. Readymade slides: -Since power point is having powerful wizards, we can prepare the slides 

easily and quickly. The auto content wizard option provides wizards to make the slides easily. The 

template provides a wide range of readymade designs to us. 
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2. Background Colors and effects: -We can have a wide variety of background colors for slides in 

power point on addition to colors we can also get different textures and shades in slides. We can 

also change the color of existing wizards and templates. 

3. Pictures: - Not only captions and different colors we can introduce good pictures either from 

clip art or from scanning the pictures. 

4. Sounds: -Different sounds can be created while presenting the various slides. The sounds will 

have a pleasing effect on the viewers. 

5. Animation: -Different animation techniques are also available in the slides. The letters and 

pictures will fly from top to bottom and from left to right. We can have many animating options; 

we can also get preview of various animation effects. 

6. Charts and tables: -We can insert different charts and tables for expressing the data and 

information to the users. The different charts and tables in the MS excel can be easily imported 

into MS power point. 

7. Time for slides: -We can prescribe the time automatically or manually for running and 

exhibiting slides. 

For example, we can set the time for 5 or 6 second for each slide to exhibit on the computer. 

8.    Speaker Notes: - Speaker notes are the notes (other features) that can be included in the 

button of the slide so, that new ideas can be discussed during presentation. 

 

Other Features: - 

MS power point includes many other features like macro’s changing the colors to the slides, font 

etc. We can also change the order of slides using slide sorter view. 

 

Advantages of power point: - 

There are many advantages of computerized presentation. 

Quick and easy: The basic features are easy to master and can make you appear to be 

organized, even if you are not. These can be created easily; one does not need to be some 

designing expert to prepare an amusing presentation. Easy to present-You can easily advance 
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the slides in the presentation one after another with a simple key stroke while still maintaining 

eye contact with the audience. 

 

Visual Impact: Making your presentation more interesting through the use of multimedia can 

help to improve the audience's focus. PowerPoint allows you to use images, audio and video to 

have a greater visual impact. These visual and audio cues may also help a presenter be more 

improvisational and interactive with the audience. 

 

Collaboration: PowerPoint allows you to work with other people in a collaborative manner. This 

is especially useful in office settings where teamwork is key. Multiple people can collaborate on 

and contribute to a presentation. By going to the "Review" tab at the top of the program and 

clicking the "New Comment" button, you can leave notes and reposition them on the screen for 

other team members to view. Comments can be an especially beneficial tool for clarification. 

 

Content Sharing: Share your PowerPoint presentation with the world. Did someone miss your 

presentation? Have them view it online at a time that is convenient for them. You can upload 

your presentation to websites such as YouTube with everything featured in your work including 

all of the slides, commentary and transitions.  

 

Blend of content and graphics: The content can be presented in the form of bullet points, 

which is a cue for the presenter. Even the readers want to read small simple lines, rather than 

paragraphs. Images, pictures and these days’ even videos have become an integral part of 

presentation to display your creativity and invite attentions. 

 

Presentation Skills: This is always at test, but with a PowerPoint Presentation the confidence is 

boosted. You do not have to be a great orator or prepare a speech; as you prepare the 

presentation, you educate yourself on the topic simultaneously. 

 

Use PowerPoint as a Photo Slide Show 
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By using PowerPoint, you can create photo slide shows or digital album for personal promotional 

uses. For instance, you can create a touching tribute to your family member or can also make a 

fun Presentation featuring childhood photos of newly wedded couple during their wedding 

reception. 

 

Simple bullet points: It can reduce complicated messages to simple bullet points. Bullet points 

are a good basis for a presentation and remind the speaker of main points and the organization 

of the message. 

 

Easy to create a colorful, attractive design: Using the standard templates and themes, you can 

create something visually appealing, even if you do not have much knowledge of basic graphic 

design principles.  

  

Easily re-order presentation: with a simple drag and drop or using key strokes, you can move 

slides to re-order the presentation. When compared to other visual aids such as charts, posters, 

or objects, it is easy to modify. PowerPoint is integrated with other products that allow you to 

include parts of documents, spread sheets, and graphics. 

 

Audience size: PowerPoint slides are generally easier to see by a large audience when projected 

than other visual aids. 

 

 

APPLICATIONS OF MS PWERPOINT: 

The main purpose of MS PowerPoint is to enable the user to create dynamic, informational slide 

shows through the use of text, graphics, and animation.  

➢ Slide shows created with the software are often displayed on projection screens for 

business, training, or educational presentations, although they can be distributed as 

stand-alone files.  

https://www.free-power-point-templates.com/articles/digital-photo-album-in-powerpoint/
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➢ PowerPoint Presentations are a way of attracting audience towards your views and 

arguments. It is one of the most helping factors behind success of every meeting.  

➢ The most popular uses of power point presentations are in modern days learning, 

corporate training sessions, business and marketing meetings, and sales gatherings. 

➢ Learning Solutions 

Power point presentation combines audio and visual both aspects, making it easier to 

understand for audience. Even the normal teaching or training becomes interactive by just 

using presentations in lectures. These days school, colleges and institutions are providing 

tailor made presentations to students for different topics in syllabus of study. That makes 

learning easier and interactive for students. 

➢ Corporate Training Session 

Power point is an essential ingredient of every corporate training session. Top executives 

and manager (marketing and sales) use this powerful tool to train their junior's or associates to 

give them better, interactive and more effective training. It's always beneficial and less time 

consuming for corporate trainers, if they use these tools in their sessions, it generates more 

results. 

➢ Marketing Strategy 

Powerful tools and options present in Microsoft power point, makes it easier for people 

in marketing, advertising, and sales to make presentations for motivation of their subordinates. 

Inclusion of different types of charts, images, clip-arts, other graphical structures, makes a 

presentation eye catchy. Animation and sound effects add extra emphasis on these presentations 

making them look more interactive. 

 

PARTS OF MS-POWERPOINT WINDOW:  

The parts of the MS-Power point window are:  

• Title Bar: The Title bar generally appears at the top of the screen. The Title bar displays the 

title of the current presentation.  

• Menu Bar: The Menu bar displays the menu. You use the menu to give instructions to 

PowerPoint. 
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• Standard and Formatting Toolbars: The most commonly used toolbars are the Standard and 

Formatting toolbars. You use the Standard toolbar to do such things as open a file; save a 

file; print a file; check spelling; cut, copy, and paste; undo and redo; or insert a chart or table. 

You use the Formatting toolbar to change the font, font size or font color; bold, underline, or 

italicize text; left align, right align, center, or justify; bullet or number lists; highlight; or 

decrease or increase the indent. 

• Rulers: Rulers are vertical and horizontal guides. You use them to determine where you want 

to place an object. They are marked in inches. 

• Placeholders: Placeholders hold the objects in your slide. You use placeholders to hold text, 

clip art, and charts. 

• Status Bar: The Status bar generally appears at the bottom the screen. The Status bar displays 

the number of the slide that is currently displayed, the total number of slides, and the name 

of the design template in use or the name of the background. 

• Outline/Slides tab displays the presentation text in the form of an outline. Outline tab is used 

to organize and develop the content of your presentation. This tab enables you to move slides 

and text by dragging selected material. Slide tab displays the slides of your presentation as 

small images. This view allows easy navigation through slides. 

• Slide pane contains the current slide in your presentation. You can use the vertical scroll bar 

to view other slides in the presentation. 

• Notes pane is located below the slide pane and is used to type reference notes. The notes 

can be printed, then referenced when making the presentation. 

• View area is located at the right hand bottom of the screen. It contains buttons that allow 

the ability to switch between PowerPoint views. The first view button allows you to view 

slides in normal view, the second is called the slide sorter view, the third is called the reader 

view and the fourth is called the slide show view. This area also contains the zoom feature. 
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Menus and Toolbars in PowerPoint window 

A menu (or drop-down menu) is the way in which actions can be performed. 

A toolbar is just a collection of icons that provides a shortcut to using the drop-down menu. 

 

A toolbar displays the commands in a simple linear display whereas menus can incorporate 

different levels. Toolbars offer quick shortcuts to commonly used commands. The toolbars 

change automatically depending on what you are doing and on your personal settings. 

You can re-position any of the toolbars using the mouse and they can be docked to any side of 

the application window. 

 

The Standard toolbar 
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As you move the mouse pointer over the icons on the Standard Toolbar (second row), you will 

see a small pop-up that names each icon, such as, New, Open, Save, email, print, spelling, cut, 

copy, paste, format painter, undo, redo, hyperlink, etc. 

 

The Formatting toolbar 

 

Use the Formatting toolbar to modify the content of your slide, such as Font style and size, 

alignment of print, numbering/bulleting, etc. 

 

The Drawing toolbar 

 

The Drawing Toolbar allows us to draw various geometric shapes, textboxes, Wordart, and clipart, 

and to color lines, letters, and fill spaces. Once the drawing is highlighted, it can be Grouped, 

Ordered, Rotated or Flipped, and other changes. 

 

The Quick Access toolbar 

 

Located just above the Ribbon, the Quick Access toolbar lets you access common 

commands no matter which tab is selected. By default, it includes the Save, Undo, Repeat, 

and Start Presentation commands. You can add other commands depending on your 

preference. You can also place the QAT below the Ribbon so that it is easily accessible and 

sport more icons. 

 

CREATING PRESENTATIONS THROUGH AUTO CONTENT WIZARD: 

The Auto Conte t Wizard guides you step – by – step through creating a Power Point presentation.  

Of all the ways to create a presentation, the AutoContent Wizard gives you the most assistance 

and automation.  To starts the AutoContent Wizard, follow these steps: 
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1. Select File, New to display the New Presentation task pane if it isn’t already displayed 

2. Click from AutoContent Wizard on the new presentation task pane.  The wizard appears  

3. Click the button for the kind of presentation you want to create.  The adjacent box 

displays the available presentations. 

4. Select the presentation you want to use and click Next. 

5. Select the type of output to use.  Choices include the following: 

• Onscreen Presentation – The standard Power Point presentation format, 

delivered on a computer screen 

• Web presentation – For presentation delivered via the Web 

• Black and white overheads – Useful as a backup or as a cost effective alternative 

to full color transparencies 

• Color overheads – For full color transparencies 

• 35mm slides – Formatted for delivery to a services bureau for conversion to 35mm 

slides. 

6. Enter a presentation title and Save it. 

7. Click finish. 

 

Templates in PowerPoint: 

A PowerPoint template acts as a blueprint for presentations you base on it. Using a template is 

a quick way to create a new presentation as layouts, color schemes and styles have already been 

designed for you, so all you need to worry about is the content you want to deliver to your 

audience. Think of it as a ready-made PowerPoint file with fill-in-the-blank-spaces that’s just 

waiting for your content to get pasted on there.  

 

Steps to use existing Templates in PowerPoint: 

1. When you open PowerPoint, you will see a list of recently opened presentations running down 

the left of the workspace. Central to the workspace, however, is a collection of PowerPoint 

templates. To select one on which to base your new presentation, click on it.  
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2. A confirmation window will open that previews what the template looks like. 

  

Each template has different color options that you can see on the right of the window. Click on 
a thumbnail to get a different color scheme. 

3. You can also navigate to the next and previous templates by using the right and left arrows 
on either side of the currently selected template. 

4. Click the Create button to create a new presentation based on this PowerPoint template. The 
new presentation will open with just one title slide, and from this point you can add your own 
content and add more slides. 

5. At any point while you are working on your presentation, you can change the template. Or 
rather, you can change the theme. Go to the Design tab and have a look in the Themes group. 
There you will see all the template designs you saw on the initial template selection screen.  

 

 

 

CREATING PRESENTATIONS BASED ON A DESIGN TEMPLATE: 

1. On the File menu, click New, and then click the Design Templates tab. 

2. Scroll to see all the design templates, click the one you want, and then click ok. 

3. Scroll to see the slide layouts, and then select a layout for your title slide. 

4. Type the title and any other content you want on the title slide. 

5. On the Formatting toolbar, click common Tasks, Click New Slide, and then select a layout 

for the next slide. 

http://www.powerpoint-2013-tutorials.com/wp-content/uploads/2013/09/themes-templates.gif
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6. Add the content you want. 

7. Repeat steps 5 and 6 for each new slide. 

8. When you finish, click Save on the File menu. 

9. Name your presentation, and then click Save. 

 

 Changing slide layout: It is possible to change slide layout of a presentation already created.  The 

steps are: 

1. In normal or slide sorter view, select the slide you want to change. 

2. On the Formatting toolbar, click common Tasks, and then click slide layout. 

3. Use the scroll bar to view all layouts, click the one you want, and then click apply. 

4. Rearrange any overlapping or hidden objects to fit the new layout. 

 

SLIDE:   

A slide is a page, document or template where all the content of a presentation is written.  It is 

just like a page of paper or page of slide show.  A single page in the slide show presentation is 

known as a slide.  A slide is a container, which can contain – texts, pictures, charts, drawing and 

animations etc., which are also known as objects.  

 

TYPES OF SLIDES: 

Power Point offers 27 different types of slide layouts divided into four categories: 

• Text Layout - A Text layout slide contains only text.  The slide might contain one or two 

columns of text, with or without a title. 

• Content Layout – Content layout slides can contain up to four pieces of content in several 

arrangements.  Content is a graph, a photo, an organization chart, or some other visual 

element. 

• Text and Content Layout – The seven text and content layouts place text and content on 

a slide in various arrangements. 
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• Other Layout – The other layouts don’t fit the other categories.  For example, you can 

create a slide with a single table, diagram, or organization chart.  You can also create 

combinations with text, media clip art, and charts. 

 

Depending on which method you use to create a new presentation, it might already contain 

slide layouts.  If you want to look at these layouts before you create a presentation, apply 

them directly to slide, or change a layout, choose Format, Slide Layout to open the Slide 

Layout task pane. 

 

The lists of slide layouts are as follows -  

1. Title Slide - Used at the start of your presentation, or to divide sections of your 

presentation. 

2. Title and Content - The default slide layout and the most commonly used slide layout. 
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3. Section Header - Use this slide type to separate different sections of the same 

presentation, rather than use an additional Title slide. It can also be used as an alternate 

to the Title slide layout. 

4. Two Content - Use this slide layout if you wish to show text in addition to a graphic 

content type. 

5. Comparison - Similar to the Two Content slide layout, but this slide type also includes a 

heading text box over each type of content. Use this type of slide layout to -  

o compare two types of the same content type (for example - two different charts)  

o show text in addition to a graphic content type 

6. Title Only - Use this slide layout if you want to place only a title on the page, rather than 

a title and subtitle. You can then insert other types of objects such as clip art, WordArt, 

pictures or charts if desired. 

7. Blank- A blank slide layout is often used when a picture or other graphic object that needs 

no further information, will be inserted to cover the whole slide. 

8. Content with Caption - Content (most often a graphic object such as a chart or picture) 

will be placed on the right side of the slide. The left side allows for a title and text to 

describe the object. 

9. Picture with Caption - The upper part of the slide is used to place a picture. Under the 

slide you can add a title and descriptive text if desired. 

 

DIFFERENT VIEWS OF SLIDE:  

 Microsoft Power Point comes with different views to help the user while creating 

presentations.  They are: 

1. Normal view, 

2. Slide sorter view 

3. Slide show view 

1. Normal View: This is the default view.  It displays three panes; the Normal View Pane, which 

includes the Outline and Slides tabs, the slide pane in the center, and the Notes pane beneath 

it.  
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• Outline Pane: 

This view helps in organizing and developing the content of the presentation.  Users 

can type the text to be presented and rearrange bullet points, paragraphs and slide. 

• Notes Pane: 

This pane can be used to add speaker notes or other relevant information to share 

with the audience.  If graphics have to be added to the notes, the users must add the notes 

in notes page view.  

• Slide pane: 

The slide pane is the largest of the three panes.  You can add text, graphics, tables, 

charts, and other objects to your presentation on the slide pane. 

 

2. Slide sorter view: Slide Sorter view displays miniature previews of all the slides in your 

presentation, making it easier for you to organize them.   

 

3. Slide show View: Slide show view displays your slides as they would appear in a slide show, 

full-screen, without any menus, toolbars, or other features.   

 

FORMATTING SLIDES: 

The slides designed in Power Point can be formatted with slide text formatting, color scheme 

formatting, adding transition, adding animation, and recording voice narration etc. 

❖ Adding transitions to a slide show: 

1. In slide or slide sorter view, select the slide or slides you want to add a transition to. 

2. On the slide show menu, click slide transition. 

3. In the effect box, click the transition you want, and then select any other options you 

want. 

4. To apply the transition to the selected slide, click apply.  To apply the transition to all the 

slides, click apply to all 

5. Repeat the process for each slide you want to add a transition to.  To view the transitions, 

on the slide show menu, click animation preview. 
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❖ Changing slide background:  

You can change the appearance of your slide background by changing its color, shade, 

pattern, or texture.  You can also use a picture as a slide background, but you can use only 

one type of background on a slide or master.  For example – you can have a shaded 

background, a textured background, or a picture as the back ground, I but you can use only 

one of these on a single slide.  When you change the backgournd, you can apply the change 

to only the current slide or to all the slides and the slide master.  

 

❖ Formatting slide with color scheme: 

The slides can be rearranged slide sorter view.  Slides can be dragged or cut and paste 

can be used to cut a slide and past it in any order in the presentation file.  If the user is satisfied 

with the presentation created, it should be saved by clicking ‘Save” on File menu. Type a file 

name and click ‘Save’.  Thus, a presentation is created and saved in PowerPoint.  It can be 

reviewed, rehearsed and modified to make them more attractive.  The user can also ad 

narration to the presentation.  Save the presentation after all the modifications are carried 

out.  

 

 

INSERTION OF OBJECTS AND CHARTS:  

❖ Inserting Slide Number, data and Time: 

1. On the View menu, click Header and Footer. 

2. To add the information to your slides, click the Slide tab. 

To add the information to notes pages and handouts, click the Notes and Handouts tab. 

       3.   Select the options you want. 

       4.   To add the information to only the current slide, click Apply. 

             To add it to all slides in the presentation, click Apply to All.  

 

❖ Insert a Picture from the Clip Gallery: 
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1. Display the slide you want to add a picture to. 

2. Click Insert Clip Art on the Drawing toolbar, and then click the pictures tab. 

3. Click the category you want. 

4. Click the picture you want, and then click Insert Clip on the shortcut menu. 

5. When you are finished using the Clip Gallery, click the Close button on the Clip Gallery 

title bar. 

 

❖ Insert an Animated GIF Picture on a Slide: 

1. Display the slide you want to add the animated GIF Picture to. 

2. Do one of the following. 

To insert an animated GIF picture from the Clip Gallery, Click Insert Clip Art on the 

Drawing toolbar and then click the Motion Clips Tab. 

To insert an animated GIF Picture from a file, on the Insert menu, point to Picture, and 

then click From File. 

       3.   Do one of the following: 

If you clicked Insert Clip Art in step2, click the animated GIF picture you want to add to 

your      slide, and then click Insert Clip on the menu that appears. 

If you clicked From File (Insert menu, picture submenu) in step2, locate the folder that 

contains the animated GIF picture you want to insert, and double-click the picture. 

      4.    To preview how the animated GIF picture will appear in the slide show, click Slide Show 

at the lower left of the MS PowerPoint window. 

 

❖ Insert an Organization Chart: 

1. Display the slide you want to add an Organization chart to. 

2. On the Insert Menu, point to Picture, and then click Organization Chart. 

3. Use the Organization chart tools and menus to design your chart. 

4. To return to PowerPoint, click Exit and Return to presentation on the Organization Chart 

File Menu. 
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CUSTOM ANIMATION AND TRANSITION: 

The Different Types of Animations in PowerPoint 

o Transitions 

o Animations 

 

Animations: 

In the simplest sense, animation is something that makes slide objects move on a slide. And slide 

objects can be anything on a slide, these include text, pictures, charts, SmartArt graphics, shapes, 

even movie clips. Animation effects in PowerPoint provide smooth visual transitions between 

different states of your presentation by moving objects in place or around the slide canvas. The 

main idea of using animations is not just to make content interactive and entertaining, but also 

to draw viewers’ attention to the key points and therefore express ideas in a more memorable 

way. 

 

Add animations to text, pictures, shapes, and more in your presentation: 

1. Select the object or text you want to animate. 

2. Select Animations and choose an animation. 

3. Select Effect Options and choose an effect. 

 You can choose from the following types of animations: 

✓ Entrance animations: The icons for this type of animation are colored green. If you use 

this type of animation for an object, that object will enter the slide according to your 

timing preferences. 

✓ Exit animation: The icons for this type of animation are colored red. The object you 

have added this animation will exit the slide. 

✓ Emphasis animations: The icons for this kind of animation are colored yellow. The 

object will not enter or exit the slide (unless you have added that particular animation to 

the same object) but will emphasize and draw attention to that object. 

✓ Motion path animations: This type of animation will allow you to move an object from 

one spot to another. You can specify or draw the path you want the object to take. 

https://24slides.com/presentbetter/add-animations-powerpoint/#The_Different_Types_of_Animations_In_PowerPoint
https://24slides.com/presentbetter/add-animations-powerpoint/#Transitions
https://24slides.com/presentbetter/add-animations-powerpoint/#Animations
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Manage animations and effects 

There are different ways to start animations in your presentation: 

➢ On Click: Start an animation when you click a slide. 

➢ With Previous: Play an animation at the same time as the previous animation in your 

sequence. 

➢ After Previous: Start an animation immediately after the previous one happens. 

➢ Duration: Lengthen or shorten an effect. 

➢ Delay: Add time before an effect runs. 

 

Transitions: 

A slide transition is how one slide is removed from the screen and the next slide is displayed 

during a presentation. PowerPoint offers many entertaining and different slide transition 

schemes. You can control the speed, add sound, and customize the look of transition effects. 

 

To add transitions to a presentation  

1. Click on the slide sorter view, located at the bottom of the screen.  

2. Select the slide you want to add a transition to. 

3. Select the Transitions tab and choose a transition. Select a transition to see a preview. 

4. Select Effect Options to choose the direction and nature of the transition. 

5. Select Preview to see what the transition looks like. 

To remove a transition 

 Select Transitions > None. 

To apply transition schemes to all the slides in your presentation  

1. Select Apply to All.  

2. You can also adjust the duration of the transition by setting a time in the Duration box 

located above Apply To All. 

3. When a transition is added to a slide, a transition icon (*) displays below the slide in all of 

the slide views. 
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Set the speed of a transition 

Use Duration to set transition speed. A shorter duration means that a slide advances faster, and a larger 

number makes the slide advance more slowly. 

1. Select the slide that has the transition that you want to modify. 

2. On the Transitions tab, in the Timing group, in the Duration box, type the number of seconds 

that you want. 

 

INSERTING, EDITING AND DELETING SLIDES: 

❖ To insert and format text in a slide:  

Step 1:Click inside a placeholder.  

Step 2:Enter text. You may use the formatting toolbar at the top of the PowerPoint window to 

apply various formats to your selected text. You may notice this toolbar is identical to the one 

used in Microsoft Word. 

 

Step 3:When you are finished entering text, click outside the placeholder on some “empty 

space.” 

❖ To delete text : 

Option #1: Highlight the text you want to delete by dragging the cursor over the letters, and 

press the delete key. 

Option #2: Click on the selection rectangle around the text so that its border changes from 

hatch marks to dots, and then press the delete key. 

❖ To insert a new slide:  

Option #1: Go to Insert->New Slide. A blank slide will appear in the workspace, positioned after 

the selected slide or slide you were viewing. 

Option #2: Click on the "New Slide” button on the formatting toolbar at the top of the 

PowerPoint window. 

 

javascript:
javascript:
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Option #3: On the Slides pane (off to the left), position your cursor to the point in the 

presentation where you would like the new slide to appear (i.e. between slides, at the 

beginning of the presentation, or at the end of the presentation). Right click, and choose “New 

slide” from the menu that appears. 

 

❖ To delete a slide:  

Option #1: Go to Edit->Delete Slide. The current slide will disappear from the workspace. 

Option #2: On the Slides pane (off to the left), click on the slide you would like to delete, and 

then hit the <Delete> key. 
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Unit IV 

E-Business and E-Commerce:- Introduction E-Business and E-Commerce , Traditional 

Commerce Vs E-Commerce, Potential Benefits, Limitations, E-Business Infrastructure, E-

Business Models, Electronic Payment Systems 

 

 

E-Commerce 

Electronic commerce (E-Commerce or EC) is an emerging concept that describes 

the process of buying and selling or exchanging of products, services, and 

information via computer networks including the Internet. It is the use of the 

Internet and the Web to transact business. Doing business online, typically via the 

Web. It is also called "e-business," "e-tailing" and "I-commerce." Although in most 

cases e-commerce and e-business are synonymous, e-commerce implies that goods 

and services can be purchased online, whereas e-business might be used as more 

of an umbrella term for a total presence on the Web, which would naturally include 

e-commerce (shopping) component. Ecommerce refers to the paperless exchange 

of business information using the following ways − 

• Electronic Data Exchange (EDI) 

• Electronic Mail (e-mail) 

• Electronic Bulletin Boards 

• Electronic Fund Transfer (EFT) 

• Other Network-based technologies 

 



Unit – IV  EIT 
 

2 
 

 
 

Features 

E-Commerce provides the following features − 

• Non-Cash Payment − E-Commerce enables the use of credit cards, debit 
cards, smart cards, electronic fund transfer via bank's website, and other 

modes of electronics payment. 

• 24x7 Service availability − E-commerce automates the business of 
enterprises and the way they provide services to their customers. It is 

available anytime, anywhere. 

• Advertising / Marketing − E-commerce increases the reach of advertising 

of products and services of businesses. It helps in better marketing 
management of products/services. 

• Improved Sales − Using e-commerce, orders for the products can be 

generated anytime, anywhere without any human intervention. It gives a 
big boost to existing sales volumes. 

• Support − E-commerce provides various ways to provide pre-sales and 
post-sales assistance to provide better services to customers. 

• Inventory Management − E-commerce automates inventory 

management. Reports get generated instantly when required. Product 
inventory management becomes very efficient and easy to maintain. 

• Communication improvement − E-commerce provides ways for faster, 
efficient, reliable communication with customers and partners. 
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Traditional Commerce v/s E-Commerce 

Electronic commerce is having so many similarities with traditional commerce. 

Electronic commerce also involves an exchange of goods. But the major difference 

is the exchange of goods and services is done online in E-commerce. Traditional 

commerce involves the exchange of goods and services between two people face to 

face. 

Traditional Commerce is part of a business that involves all the activities that 

expedite business. The main two kinds of actions include trade and trading 

auxiliaries. Trading is, of course, the buying and selling of goods and services for 

money.  Trading auxiliaries refer to business-related activities such as banking, 

transportation, insurance, packaging, marketing and advertisements, and more. 

 

Ecommerce also electronic commerce is like traditional commerce. As such, it 

also involves the exchange of goods and services.  The only difference is that it is 

conducted online via an electronic network – the Internet. Nowadays it has 

extended to online social networks.  With e-commerce, transactions, assistance, 

and communication are done through the use of the electronic medium. 

 

 

Feature E-commerce Traditional commerce 

Definition E-Commerce is a form of online 

shopping where users can buy 

goods and services from their 

electronic devices such as a 

laptop, mobile, tablet. 

Traditional-Commerce is a 

traditional approach to buy goods 

and services in person which 

involves face to face dealing. 

Usage It is used to save valuable time 

and money. 

It is ancient and still in usage 

where the digital network is not 

reachable. 
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Process It is easier to use and operate if 

the customer has basic digital 

gadget knowledge. 

It can be followed by any person 

irrespective of education or 

knowledge. 

Mode It is in electronic or digital mode 

only 

It can be in any form which is non-

electronic or manual form. 

Time It is available round the clock It is available during the limited 

time as prescribed by the law and 

based on the type of business. 

Purchase Inspecting a product before 

purchasing is not possible in this 

type. 

Inspecting a product before 

purchasing is possible in a 

traditional commerce business 

model. 

Involvement It involves only digital gadget 

engagement to place the order 

It involves face to face 

involvement of both buyer and 

seller 

Business More business can be done 

easily without any hassles 

It is difficult to perform more 

business in this model 
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Maintenance Easier to maintain this as the 

only warehouse is enough to 

store the goods. 

It is cost effective as display and 

showcase of the products are 

required to attract the customers. 

 

 

Advantages of E-Commerce 

E-Commerce advantages can be broadly classified in three major categories − 

• Advantages to Organizations 

• Advantages to Consumers 

• Advantages to Society 

 

Advantages to Organizations 

• Using e-commerce, organizations can expand their market to national and 

international markets with minimum capital investment. An organization can 

easily locate more customers, best suppliers, and suitable business partners 

across the globe. 

• E-commerce helps organizations to reduce the cost to create process, 

distribute, retrieve and manage the paper based information by digitizing 

the information. 

• E-commerce improves the brand image of the company. 

• E-commerce helps organization to provide better customer services. 

• E-commerce helps to simplify the business processes and makes them faster 

and efficient. 

• E-commerce reduces the paper work. 

• E-commerce increases the productivity of organizations.  

 

Advantages to Customers 

• It provides 24x7 support. Customers can enquire about a product or service 

and place orders anytime, anywhere from any location. 
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• E-commerce application provides users with more options and quicker 

delivery of products. 

• E-commerce application provides users with more options to compare and 

select the cheaper and better options. 

• A customer can put review comments about a product and can see what 

others are buying, or see the review comments of other customers before 

making a final purchase. 

• E-commerce provides options of virtual auctions. 

• It provides readily available information. A customer can see the relevant 

detailed information within seconds, rather than waiting for days or weeks. 

• E-Commerce increases the competition among organizations and as a result, 

organizations provides substantial discounts to customers. 

 

Advantages to Society 

• Customers need not travel to shop a product, thus less traffic on road and 

low air pollution. 

• E-commerce helps in reducing the cost of products, so less affluent people 

can also afford the products. 

• E-commerce has enabled rural areas to access services and products, which 

are otherwise not available to them. 

• E-commerce helps the government to deliver public services such as 

healthcare, education, social services at a reduced cost and in an improved 

manner. 

 

Limitations of E-Commerce 

The disadvantages of e-commerce can be broadly classified into two major 

categories − 

• Technical disadvantages 

• Non-Technical disadvantages 

Technical Limitations 

• There can be lack of system security, reliability or standards owing to poor 

implementation of e-commerce. 
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• The software development industry is still evolving and keeps changing 

rapidly. 

• In many countries, network bandwidth might cause an issue. 

• Special types of web servers or other software might be required by the 

vendor, setting the e-commerce environment apart from network servers. 

• Sometimes, it becomes difficult to integrate an e-commerce software or 

website with existing applications or databases. 

• There could be software/hardware compatibility issues, as some e-commerce 

software may be incompatible with some operating system or any other 

component. 

Non-Technical Disadvantages 

• Initial cost − The cost of creating/building an e-commerce application in-

house may be very high. There could be delays in launching an e-Commerce 

application due to mistakes, and lack of experience. 

• User resistance − Users may not trust the site being an unknown faceless 

seller. Such mistrust makes it difficult to convince traditional users to switch 

from physical stores to online/virtual stores. 

• Security/ Privacy − It is difficult to ensure the security or privacy on online 

transactions. 

• Lack of touch or feel of products during online shopping is a drawback. 

• E-commerce applications are still evolving and changing rapidly. 

• Internet access is still not cheaper and is inconvenient to use for many 

potential customers, for example, those living in remote villages. 

 

 

E-Business 

E-Business involve carrying of business activities such as designing of products, 

operating supply chain, marketing products, and providing services to stakeholder 

using electronic  technology. 

Through E-Business several online operations can be carried out such as: 

1. Buying and selling of goods and services. 

2. Providing customer service. 
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3. Providing E-Learning facilities. 

4. Joining with different partners to work together 

 

E-Business Models 

E-commerce business models can generally be categorized into the following 

categories. 

• Business - to - Business (B2B) 

• Business - to - Consumer (B2C) 

• Consumer - to - Consumer (C2C) 

• Consumer - to - Business (C2B) 

• Business - to - Government (B2G) 

• Government - to - Business (G2B) 

• Government - to - Citizen (G2C) 

 

Business - to - Business 

A website following the B2B business model sells its products to an intermediate 

buyer who then sells the product to the final customer. As an example, a 

wholesaler places an order from a company's website and after receiving the 

consignment, sells the end product to the final customer who comes to buy the 

product at one of its retail outlets. 
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Business - to - Consumer 

A website following the B2C business model sells its products directly to a 

customer. A customer can view the products shown on the website. The customer 

can choose a product and order the same. The website will then send a notification 

to the business organization via email and the organization will dispatch the 

product/goods to the customer. 

 

Consumer - to - Consumer 
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A website following the C2C business model helps consumers to sell their assets 

like residential property, cars, motorcycles, etc., or rent a room by publishing their 

information on the website. Website may or may not charge the consumer for its 

services. Another consumer may opt to buy the product of the first customer by 

viewing the post/advertisement on the website. 

 

 

Consumer - to - Business 

In this model, a consumer approaches a website showing multiple business 

organizations for a particular service. The consumer places an estimate of amount 

he/she wants to spend for a particular service. For example, the comparison of 

interest rates of personal loan/car loan provided by various banks via websites. A 

business organization who fulfills the consumer's requirement within the specified 

budget, approaches the customer and provides its services. 
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Business - to - Government 

B2G model is a variant of B2B model. Such websites are used by governments to 

trade and exchange information with various business organizations. Such 

websites are accredited by the government and provide a medium to businesses to 

submit application forms to the government. 

 

Government - to - Business 

Governments use B2G model websites to approach business organizations. Such 

websites support auctions, tenders, and application submission functionalities. 

 

Government - to - Citizen 

Governments use G2C model websites to approach citizen in general. Such 

websites support auctions of vehicles, machinery, or any other material. Such 

website also provides services like registration for birth, marriage or death 

certificates. The main objective of G2C websites is to reduce the average time for 

fulfilling citizen’s requests for various government services. 
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ELECTRONIC PAYMENT SYSTEMS 

Introduction: 

➢ E-Commerce or Electronics Commerce sites use electronic payment where 

electronic payment refers to paperless monetary transactions. 

➢ Electronic payment has revolutionized the business processing by reducing 

paper work, transaction costs, labour cost. Being user friendly and less time 

consuming than manual processing, helps business organization to expand its 

market reach / expansion. 

➢ Electronic payment is an integral part of electronic commerce. Broadly defined, 

electronic payment is a financial exchange that takes place online between 

buyers and sellers. The content of this exchange is usually some form of digital 

financial instrument (such as encrypted credit card numbers, electronic checks, 

or digital cash) that is backed by a bank or an intermediary, or by legal tender.  

➢ Three factors are stimulating interest among financial institutions in electronic 

payments: decreasing technology costs, reduced operational and processing 

costs, and increasing online commerce. 

 

Online Payment Systems: 

These are a few things to know about online payment systems. 

➢ ACH payments are electronic credit and debit transfers, allowing customers 

to make payments from their bank accounts for utilities, mortgage loans, 

and other types of bills. ACH stands for Automated Clearing House and 

most payment processors offer ACH payment options to their customers, 

especially for monthly- and subscription-based transactions. Most payment 

solutions use ACH to send money (minus fees) to their customers. 

➢ A merchant account is a bank account that allows a customer to receive 

payments through credit or debit cards. Merchant providers are required to 

obey regulations established by card associations. Many processors act as 

both the merchant account as well as the payment gateway. 

➢ A payment gateway allows merchants to securely pass credit card 

information between the customer and the merchant and also between 
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merchant and the payment processor. The payment gateway is the 

middleman between the merchant and their sponsoring bank. 

➢ A payment processor is the company that a merchant uses to handle 

credit card transactions. Payment processors implement anti-fraud 

measures to ensure that both the front-facing customer and the merchant 

are protected. 

➢ PCI compliance is when a merchant or payment gateway sets their 

payment environment up in a way that meets the Payment Card Industry 

Data Security Standard (PCI DSS). The PCI DSS standard was created 

by the Payment Card Industry Security Standards Council to increase 

security of cardholder data and to reduce fraud. 

 

 

Types of Electronic Payment Systems: 

➢ E Cash / E Money:  

• A system that allows a person to pay for goods or services by transmitting a 

number from one computer to another. Like the serial numbers on real 

currency notes, the E-cash numbers are unique.  

• This is issued by a bank and represents a specified sum of real money. It is 

anonymous and reusable. 

➢ E-Wallet:  

• The E-wallet is another payment scheme that operates like a carrier of e-

cash and other information.  

• The aim is to give shoppers a single, simple, and secure way of carrying 

currency electronically.  

• Trust is the basis of the e-wallet as a form of electronic payment. 

➢ Smart Card: 

• A smart card, is any pocket-sized card with embedded integrated circuits 

which can process data.  

• This implies that it can receive input which is processed and delivered as an 

output.  

➢ Credit Card:  
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• It is a Plastic Card having a Magnetic Number and code on it. 

• It has some fixed amount to spend.   

• Customer has to repay the spend amount after sometime.  

➢ Debit Card: 

• Similar to Credit card on coding and encryption.  

• Purchase limit depends on the available balance in the account. 

➢ Stored-value card : 

• A card with a certain amount of money that can be used to perform the 

transaction in the issuer store. 

• A typical example of stored-value cards are gift cards. 
 

 

  

Pros and cons of EPS: 

Pros:  

✓ It’s easier for customers to buy your products or services.  

✓ You can add custom loyalty programs, gift cards and customized e-commerce 

websites.  

✓ You can integrate it with accounting software, making it easier to manage 

money.  
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✓ You don’t have to waste as much time depositing paper checks and cash at 

the bank.  

 

Cons:  

✓ You have to pay a processing fee to accept plastic and some other electronic 

payments.  

✓ If you use a traditional physical credit card terminal, monthly or annual fees 

might apply.  

✓ Some payment processing services lock you into contracts that are costly to 

terminate early.  

✓ To accept credit cards you usually need a merchant account, which is a bank 

account where payments are deposited. Many electronic payment systems 

include one as a built-in feature. Note that you don’t need a merchant 

account if you use a third-party processor such as PayPal.  

 

Payment Gateways: 

Definition: Payment gateway is an application on an e-commerce website that 

allows the website to link the client payment account with the website’s account. 

Payment gateways allows for the credit account details to be secure instead being 

sent online.  

 

How payment gateways work: 

When a customer places an order from an online store, the payment gateway 

performs several tasks to finalize the transaction: 

➢ Encryption: The web browser encrypts the data to be sent between it 

and the vendor's web server. The gateway then sends the transaction 

data to the payment processor utilized by the vendor's acquiring bank. 

➢ Authorization Request: The payment processor sends the transaction 

data to a card association. The credit card's issuing bank views the 

authorization request and “approves” or “denies.” 

➢ Filling the Order: The processor then forwards an authorization 

pertaining to the merchant and consumer to the payment gateway. Once 
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the gateway obtains this response, it transmits it to the website/interface 

to process the payment. Here, it is interpreted and an appropriate 

response is generated. This seemingly complicated and lengthy process 

typically takes only a few seconds at most. At this point, the merchant fills 

the order. 

 

The following are the 10 best Online Payment Systems in Present day market. 

1. Authorize.Net is the Internet’s most widely used payment gateway. 

2. PayPal is the world’s most widely used payment acquirer, processing over 

$4 billion in payments in 2011 

3. Google Checkout is Google’s answer to PayPal. Google Checkout allows 

users to pay for goods and services through an account connected to their 

Google profile.  

4. Amazon Payment allows its users to receive money using its API (and to 

send money out via ACH).  

5. Dwolla is a direct competitor to PayPal. One of the newcomers in the third-

party payments space, the company is processing over $1 million per day.  

6. Stripe provides an excellent payment solution for web developers who would 

like to integrate a payment system into their projects using Stripe’s robust 

API.  

7. Braintree is an online payment gateway and merchant account solution 

known for working with popular tech startups such 

as Airbnb and LivingSocial. 

8. Samurai is a payment gateway and merchant account solution.  

9. WePay is a payment processor that allows Internet merchants to accept 

credit cards and bank account payments online.  

10.Checkout is another payment processor that combines a merchant account 

and payment gateway into one, allowing customers to receive credit card 

payments as well as PayPal payments. The company offers international 

payments, shopping cart stores as well as a recurring billing feature. 

 

 

https://due.com/payments/
http://www.airbnb.com/
http://www.livingsocial.com/cities/13-san-jose
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E-Business Infrastructure: 

E-business infrastructure is the architecture of hardware, software, content and 

data used to deliver e-business services to employees, customers and partners.  

The different components of e-business architecture which need to be managed 

relate to each other. The different components can be conceived of as different 

layers with defined interfaces between each layer. The different layers can best be 

understood in relation to a typical task performed by a user of an e-business 

system. A five-layer model of e-business infrastructure is shown below- 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➢ Defining an adequate E-business infrastructure is vital to all companies 

adopting E- business as it affects directly the quality of system in terms of 

speed and responsiveness. 
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➢ A key decision with managing this infrastructure is which elements are 

located within the company and which are managed externally as third-party 

managed applications, data servers, and networks. 

➢ It is also important to be flexible enough to consider new technologies to 

support changes 

➢ Required by the business to compete effectively. 

 

Managing Infrastructure: 

Managing hardware and system software infrastructure: 

a. Systems Software - Layer II 

The key management decision is standardization throughout the organization 

this leads to reduced numbers of contacts for support and maintenance and 

reduce the purchase prices through multi-user licenses 

Systems software choices occur for client, server and network 

➢ Client: which browser to standardize on, standardize plug-ins and 

system software 

➢ Server: standardize the web-server; eg. Apache, this can help 

maintenance 

➢ Network: networking software should be decided on; eg. Novell 

 

b. Transport or Network - Layer Ill 

Decisions on the network will be based on the internal company network, 

which e-business will be intranet for external network which will be extranet 

or VPN, or links to the public Internet. The main management decision is 

whether internal or external network management will be performed by the 

company or outsourced to a third party. 

c.   Storage - Layer IV 

Storage can be managed internally or externally e.g. intranet and extranet 

are commonly managed internally, while Internet storage such as corporate 

website is commonly managed externally or at the application service 

provider. 

Managing the Applications Infrastructure. 
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➢ E-business applications infrastructure: Applications that provide access 

to services and Information inside and beyond organization  

➢ Enterprise resource planning ERP applications: Software providing 

integrated functions for major business functions such as production, 

distribution, sales, finance, and human resources management 
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Unit – V 

An Overview Of Management Information Systems (MIS): The meaning and role of MIS : 

What is MIS?, Decision support systems, systems approach, the systems view of business, MIS 

organization within the company, Managers view of Information systems. 

 

 

What is MIS? 

The Management Information System (MIS) is a concept of the last decade or two. It has been 

understood and described in a number ways. It is also known as the Information System, the 

Information and Decision System, the Computer- based information System.  

 

The MIS has more than one definition, some of which are give below. 

1. The MIS is defined as Computer based Information System which provides information 

support for decision making in the organization.  

2. The MIS is defined as an integrated system of man and machine for providing the 

information to support the operations, the management and the decision making function in 

the organization.  

3. The MIS is defined as a system based on the database of the organization evolved for the 

purpose of providing information to the people in the organization.  

4. The MIS is an idea which is associated with man, machine, marketing and methods for 

collecting information’s from the internal and external source and processing this 

information for the purpose of facilitating the process of decision-making of the business. 

 

However, in today’s world MIS a computerized business processing system generating 

information for the people in the organization to meet the information needs decision making to 

achieve the corporate objective of the organization. In any organization, small or big, a major 

portion of the time goes in data collection, processing, documenting it to the people.Hence, a 

major portion of the overheads goes into this kind of unproductive work in the organization. 

Every individual in an organization is continuously looking for some information which is 

needed to perform his/her task. Hence, the information is people-oriented and it varies with the 

nature of the people in the organization.  
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The difficulty in handling this multiple requirement of the people is due to a couple of reasons. 

The information is a processed product to fulfill an imprecise need of the people. It takes time to 

search the data and may require a difficult processing path. It has a time value and unless 

processed on time and communicated, it has no value. The scope and the quantum of information 

is individual dependent and it is difficult to conceive the information as a well-defined product 

for the entire organization.  

 

Since the people are instrumental in any business transaction, a human error is possible in 

conducting the same. Since a human error is difficult to control, the difficulty arises in ensuring a 

hundred per cent quality assurance of information in terms of completeness, accuracy, validity, 

timeliness and meeting the decision making needs.  

 

In order to get a better grip on the activity of information processing, it is necessary to have a 

formal system which should take care of the following points:  
 

▪ Handling of a voluminous data.  

▪ Confirmation of the validity of data and transaction.  

▪ Complex processing of data and multidimensional analysis. 

▪ Quick search and retrieval. Mass storage.  

▪ Communication of the information system to the user on time.  

▪ Fulfilling the changing needs of the information.  

 

The management information system uses computers and communication technology to deal 

with these points of supreme importance. 

 

Objectives of MIS:  

1. Data Capturing: MIS capture data from various internal and external sources of 

organization. Data capturing may be manual or through computer terminals.  

2. Processing of Data: The captured data is processed to convert into required information. 

Processing of data is done by such activities as calculating, sorting, classifying, and 

summarizing.  

3. Storage of Information: MIS stores the processed or unprocessed data for future use. If any 

information is not immediately required, it is saved as an organization record, for later use.  
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4. Retrieval of Information: MIS retrieves information from its stores as and when required 

by various users.  

5. Dissemination of Information: Information, which is a finished product of MIS, is 

disseminated to the users in the organization. It is periodic or online through computer 

terminal.  

 

Characteristics of MIS: 

1. Systems Approach: The information system follows a systems approach. Systems approach 

means taking a comprehensive view or a complete look at the interlocking sub-systems that 

operate within an organization.  

2. Management Oriented: Management oriented characteristic of MIS implies that the 

management actively directs the system development efforts. For planning of MIS, top-down 

approach should be followed. Top down approach suggests that the system development 

starts from the determination of management’s needs and overall business objective. To 

ensure that the implementation of system’s polices meet the specification of the system, 

continued review and participation of the manager is necessary.  

3. Need Based: MIS design should be as per the information needs of managers at different 

levels.  

4. Exception Based: MIS should be developed on the exception based also, which means that 

in an abnormal situation, there should be immediate reporting about the exceptional situation 

to the decision –makers at the required level.  

5. Future Oriented: MIS should not merely provide past of historical information; rather it 

should provide information, on the basis of future projections on the actions to be initiated. 

6. Integrated: Integration is significant because of its ability to produce more meaningful 

information. Integration means taking a comprehensive view or looking at the complete 

picture of the interlocking subsystems that operate within the company. 

7. Common Data Flow: Common data flow includes avoiding duplication, combining similar 

functions and simplifying operations wherever possible. The development of common data 

flow is an economically sound and logical concept, but it must be viewed from a practical 

angle.  

8. Long Term Planning: MIS is developed over relatively long periods. A heavy element of 

planning should be involved. 
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9. Sub System Concept: The MIS should be viewed as a single entity, but it must be broken 

down into digestible sub-systems which are more meaningful.  

10. Central database: In the MIS there should be common data base for whole system 

 

The Meaning and Role of MIS: 

Managers make decisions. Decision-making generally takes a four-fold path:  Understanding the 

need for decision or the opportunity, 

•  Preparing alternative course of actions, 

•  Evaluating all alternative course of actions, 

•  Deciding the right path for implementation. 

• MIS is an information system that provides information in the form of standardized reports and 

displays for the managers.  

 

MIS is a broad class of information systems designed to provide information needed for effective 

decision making. Data and information created from an accounting information system and the 

reports generated thereon are used to provide accurate, timely and relevant information needed 

for effective decision making by managers.  

 

Management information systems provide information to support management decision making, 

with the following goals:  Pre-specified and preplanned reporting to managers. 

▪ Interactive and ad-hoc support for decision making. 

▪ Critical information for top management. 

▪ MIS is of vital importance to any organization, because:It emphasizes on the 

management decision making, not only processing of datagenerated by business 

operations.  It emphasizes on the systems framework that should be used for 

organizinginformation systems applications. 

 

 

 

 

Role of the Management Information System:  
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The role of the MIS in an organization can be compared to the role of heart in the body. The 

information is the blood and MIS is the heart. In the body the heart plays the role of supplying 

pure blood to all the elements of the body including the brain.  

 

The heart works faster and supplies more blood when needed. It regulates and controls the 

incoming impure blood, processes it and sends it to the destination in the quantity needed. It 

fulfills the needs of blood supply to human body in normal course and also in crisis. The MIS 

plays exactly the same role in the organization.  

1) The system ensures that an appropriate data is collected from the various sources, 

processed, and sent further to all the needy destinations. The system is expected to fulfill 

the information needs of an individual, a group of individuals, the management 

functionaries: the managers and the top management. 

2) The MIS satisfies the diverse needs through a variety of systems such as Query Systems, 

Analysis Systems, Modeling Systems and Decision Support Systems the MIS helps in 

Strategic Planning, Management Control, Operational Control and Transaction 

Processing.  

3) The MIS helps the clerical personnel in the transaction processing and answers their 

queries on the data pertaining to the transaction, the status of a particular record and 

references on a variety of documents. The MIS helps the junior management personnel by 

providing the operational data for planning, scheduling and control, and helps them 

further in decision making at the operations level to correct an out of control situation. 

4) The MIS helps the middle management in short them planning, target setting and 

controlling the business functions. It is supported by the use of the management tools of 

planning and control. The MIS helps the top management in goal setting, strategic 

planning and evolving the business plans and their implementation.  

5) The MIS plays the role of information generation, communication, problem identification 

and helps in the process of decision making. The MIS, therefore, plays a vital role in the 

management, administration and operations of an organization. 

 

 

 

 

The Need for MIS: 



EIT   Unit - V 

6 
 

The following are some of the justifications for having an MIS system 

• Decision makers need information to make effective decisions. Management Information 

Systems (MIS) make this possible. 

• MIS systems facilitate communication within and outside the organization – employees 

within the organization are able to easily access the required information for the day to 

day operations. Facilitates such as Short Message Service (SMS) & Email make it 

possible to communicate with customers and suppliers from within the MIS system that 

an organization is using. 

• Record keeping – management information systems record all business transactions of an 

organization and provide a reference point for the transactions. 

 

The Component of an Information System includes: 

A hardware which is used for input/output process and storage of data, software used to process 

data and also to instruct the hand-ware component, data bases which is the location in the system 

where all the organization data will be automated and procedures which is a set of documents 

that explain the structure of that management information system. 

 

Components of MIS 

The major components of a typical management information system are; 

• People – people who use the information system 

• Data – the data that the information system records 

• Business Procedures – procedures put in place on how to record, store and analyze data 

• Hardware – these include servers, workstations, networking equipment, printers, etc. 

• Software – these are programs used to handle the data. These include programs such as 

spreadsheet programs, database software, etc 
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.   System View of Business 

 

Decision Support Systems 

Decision support systems (DSS) are interactive software-based systems intended to help 

managers in decision-making by accessing large volumes of information generated from various 

related information systems involved in organizational business processes, such as office 

automation system, transaction processing system, etc. 

DSS uses the summary information, exceptions, patterns, and trends using the analytical 

models. A decision support system helps in decision-making but does not necessarily give a 

decision itself. The decision makers compile useful information from raw data, documents, 

personal knowledge, and/or business models to identify and solve problems and make 

decisions. 

 

Attributes of a DSS 

▪ Adaptability and flexibility 

▪ High level of Interactivity 

▪ Ease of use 

▪ Efficiency and effectiveness 

▪ Complete control by decision-makers 

▪ Ease of development 

▪ Extendibility 
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▪ Support for modeling and analysis 

▪ Support for data access 

▪ Standalone, integrated, and Web-based 

 

Characteristics of a DSS 

▪ Support for decision-makers in semi-structured and unstructured problems. 

▪ Support for managers at various managerial levels, ranging from top executive to line 

managers. 

▪ Support for individuals and groups. Less structured problems often requires the 

involvement of several individuals from different departments and organization level. 

▪ Support for interdependent or sequential decisions. 

▪ Support for intelligence, design, choice, and implementation. 

▪ Support for variety of decision processes and styles. 

▪ DSSs are adaptive over time. 

 

Benefits of DSS 

• Improves efficiency and speed of decision-making activities. 

• Increases the control, competitiveness and capability of futuristic decision-making of the 

organization. 

• Facilitates interpersonal communication. 

• Encourages learning or training. 

• Since it is mostly used in non-programmed decisions, it reveals new approaches and sets 

up new evidences for an unusual decision. 

• Helps automate managerial processes. 

 

Components of a DSS 

Following are the components of the Decision Support System − 

• Database Management System (DBMS) − To solve a problem the necessary data may 

come from internal or external database. In an organization, internal data are generated 

by a system such as TPS and MIS. External data come from a variety of sources such as 

newspapers, online data services, databases (financial, marketing, human resources). 



EIT   Unit - V 

9 
 

• Model Management System − It stores and accesses models that managers use to make 

decisions. Such models are used for designing manufacturing facility, analyzing the 

financial health of an organization, forecasting demand of a product or service, etc. 

Support Tools − Support tools like online help; pulls down menus, user interfaces, 

graphical analysis, error correction mechanism, facilitates the user interactions with the 

system. 

 

System Approach: 

Following are the important features of systems approach to management thought: 

1. System approach considers the organization as a dynamic and inter-related set of parts. 

Each part represents a department or a sub-system. Each department has its sub-system. 

Continuous and effective interaction of sub-systems helps to attain goals of the larger 

system. Thus, every sub-system is a system and has sub-systems which together make an 

organization a set of mutually dependent parts and their sub-parts. 

2. It considers the impact of both near and distant future on organizational activities. 

Organizations constantly respond to changes in the internal and external environmental 

conditions. They also act as market leaders in the dynamic, competitive environment. 

3. System approach integrates goals of different parts of the organization (sub-systems or 

departments) with the organization as a whole. It also integrates goals of the organization 

with goals of the environment or society in which it operates. Integration of goals 

maintains equilibrium or balance and enables organizations to grow in the dynamic 

environment. 

4. It synthesizes knowledge of different fields of study such as biology, sociology, 

psychology, information systems, economics etc. As business organization deals with 

different components of society, it makes best use of different fields of study to improve 

interaction with its counterparts. 

5. System approach enables organizations to frame policies that promote business objectives 

and social objectives. Business operates in the social system and social values, culture, 

beliefs and ethics are important constituents of business operations. 

 

Evaluation of System Approach: 

The system approach has the following merits: 
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1. System approach provides a holistic view of the organizations and emphasizes on their 

adaptive nature. It increases organization’s adaptability to environmental changes. The 

organization is studied as a whole and not through its parts. This enables it to adapt to the 

needs of the environment. Decisions are made keeping in mind organization-environment 

interface. 

2. It analyses the system at different levels and inter-relates and integrates it into a unified 

set of direction. Starting from individual goals, it focuses on overall organizational goals, 

synthesizes the two and converges them into global economy. 

3. System approach provides a framework for effective interaction of parts of the 

organization in a specific arrangement for attainment of its goals. It does not focus on one 

part of the organization. 

4. It considers the impact of environment on the organization and vice versa. Interaction of 

external environment with the internal environment is the most significant contribution of 

systems theory.System approach, thus, analyses the organization as an adaptive and 

dynamic entity. 

5. System approach synthesizes the classical and behavioral theories into a broader 

framework to solve managerial problems.It, thus, focuses on organizations as multi-

dimensional in nature. 

 

Limitations of System Approach: 
 

1. Critics of this theory claim this as a theoretical approach to management. The way an 

organization actually works and solves problems (by applying different techniques and 

methods) has no appeal in the theory. 

2. Relationship amongst parts of the organization is emphasized upon but the exact nature 

of inter-dependence is not defined. 

3. Exact relationship between internal and external environment of the organization is also 

not defined. 

For example, it specifies that change in economic policies necessitates change in internal 

policies of the organization but what changes are required to match the changes in 

economic environment is not talked about. 

4. System approach fails to provide uniform approach to management. Management 

practices change with changes in environmental variables. No standard set of principles 

apply to all types of organizations. 
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It has added nothing new to the study of management. Even before this approach was 

introduced, managerial decisions were taken keeping in mind the environmental 

variables. No specific decision-making techniques are offered to deal with specific 

problems. 

5. It fails to provide concepts that apply to all types of organizations. The small 

organizations are less adaptive to environmental variables than large organizations. The 

theory assumes that most of the organizations are big, complex and open systems. It, 

thus, fails to provide a unified theory. 

 

MIS Organization within the Company: 

A Management Information System or MIS is used by businesses to gather, compile and 

analyze information. Today, an MIS is highly integrated with a company's computer systems, 

usually involving databases with vast amounts of data. While the type of information used can 

vary from one business to another and even between departments, the role of management 

information systems is almost always the same: to improve operations, strategies and 

decision-making. 

1. The Role of MIS Today 

The amount of information available to any business today can be overwhelming. How 

this information is managed and therefore leveraged to better decisions depends on the 

goals and objectives of your business. Just as no two people use their cell phones for 

the same things, no two businesses use MIS in the same way. To understand the 

functions of management information systems in an organization, it's best viewed at 

four different levels: transactions, operations, management and strategy. 

2. The Role of MIS in Transactions 

Information management begins at the transaction level, where the information is 

gathered and stored. This means deciding which information is important enough to be 

collected and stored. For example, if your business sells clothes online, you would 

probably record customer information, including names, addresses and purchase 

history. Once this information is compiled, it would give you insight into your 

customers' demographics and preferences. However, if you also recorded items they 

searched for, items they browsed for more than a few seconds and items they removed 

from their shopping carts, you would have much more information that could tell you 

how you can improve your sales. 



EIT   Unit - V 

12 
 

Even at the transaction level, an MIS can have a vital role in your organization. 

Suppose a customer calls to ask about an item. If the customer service representative 

has the customer's transaction history at his or her fingertips, he or she could more 

easily assist by immediately knowing the customer's name, purchase history and returns 

history. Knowing if the customer is calling from New York or Los Angeles, the 

representative can more easily predict how long an item will take to be shipped. 

3. MIS in Operations and Management 

Having accurate and timely information can help all operations in a company to make 

better decisions and to ensure everything runs smoothly. Knowing exactly how many 

orders have been placed, the production department will know how much work they 

have to do today. 

Information used at the operations level often goes hand-in-hand with better 

management decisions. For example, if the warehouse manager knows that 500 

customers have pre-ordered an item that is due to arrive on Friday, he may decide to 

have a few workers come in on Saturday to reduce Monday's workload. At the same 

time, the accounting department will know that there will be an influx of cash when 

Monday's credit-card orders are all processed. The marketing department will be able to 

determine which ad campaigns were responsible for the bulk of those orders and which 

should be used again. 

4. The Role of MIS in Business Strategy 

A well-optimized management information system can pay off beyond operations and 

management decisions. As the owner of a small company, you can review purchases 

over the past year to determine which markets to explore next. For example, suppose 

your retail website originally sold dresses and other garments and last year you began 

offering shoes at a good profit margin. Today, however, dresses account for very few 

sales and a high percentage of returns. Sales of shoes have been steadily increasing. At 

the same time, your web developers have pointed out that "handbags" and "belts" are 

now the most popular search items on your website. Based on this information, you 

have the information you need to phase out dresses and begin offering these sought -

after accessories to your customers. 

To facilitate the management decision making at all levels of company, the MIS must be 

integrated. MIS units are companywide. MIS is available for the Top management. The top 
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management of company should play an active role in designing, modifying and maintenance 

of the total organization wide management information system. 

Information system and Information technology have become a vital component of any 

successful business and are regarded as major functional areas just like any other functional 

area of a business organization like marketing, finance, production and HR. Thus it is 

important to understand the area of information system just like any other functional area in 

the business. MIS is important because all businesses have a need for information about the 

tasks which are to be performed. Information and technology is used as a tool for solving 

problems and providing opportunities for increasing productivity and quality. 

Information has always been important but it has never been so available, so current and so 

overwhelming. Efforts have been made for collection and retrieval of information, However, 

challenges still remain in the selection analysis and interpretation of the information that will 

further improve decision making and productivity. 

 

MIS for a Business Organization:   

• Support the Business Process: Treats inputs as a request from the customer and 

outputs as services to customer. Supports current operations and use the system to 

influence further way of working. 

• Support Operation of a Business Organization: MIS supports operations of a 

business organization by giving timely information, maintenance and enhancement 

which provides flexibility in the operation of an organizations. 

• To Support Decision Making: MIS supports the decision making by employee in 

their daily operations. MIS also supports managers in decision making to meet the 

goals and objectives of the organization. Different mathematical models and IT tools 

are used for the purpose evolving strategies to meet competitive needs.  

• Strategies for an Organization: Today each business is running in a competitive 

market. MIS supports the organization to evolve appropriate strategies for the business 

to assented in a competitive environment. 

 

Managers View of Information Systems: 

Advances in computer-based information technology in recent years have led to a wide 

variety of systems that managers are now using to make and implement decisions. By and 

http://ecomputernotes.com/fundamental/information-technology/what-do-you-mean-by-data-and-information
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large, these systems have been developed from scratch for specific purposes and differ 

significantly from standard electronic data processing systems.  

Too often, unfortunately, managers have little say in the development of these decision 

support systems; at the same time, non-managers who do develop them have a limited view of 

how they can be used. In spite of these drawbacks, the author found that a number of the 56 

systems he studied are successful. And the difference between success and failure is the extent 

to which managers can use the system to increase their effectiveness within their 

organizations. Thus, the author suggests that this is the criterion designers and managers 

should jointly ascribe to in exploiting the capabilities of today’s technologies.  

• First, managers and computer users in many organizations are familiar with only a few of 

the types of systems now in use. As a result, different types of innovative systems have 

often been conceived and nurtured by internal or external “entrepreneurs,” not by the 

system users or their superiors. 

• Second, and closely related to my first finding, these entrepreneurs tend to concentrate on 

technical characteristics. Too often, this myopia means that they fail to anticipate the 

ways in which such systems can be used to increase the effectiveness of individuals in 

organizations. 

• Finally, highly innovative systems—the very ones management should find most 

useful—run a high risk of never being implemented, especially when the impetus for 

change comes from a source other than the potential user. 

 

Types of Decision Support Systems 

While there are many ways to categorize computer systems, a practical one is to compare them 

in terms of what the user does with them: 

• Retrieves isolated data items. 

• Uses as a mechanism for ad hoc analysis of data files. 

• Obtains pre-specified aggregations of data in the form of standard reports. 

• Estimates the consequences of proposed decisions. 

• Proposes decisions. 

• Makes decisions. 

Spectrum of possibilities 

Although managers in most large companies have used budgeting or planning systems similar to 

the source-and-application-of-funds model, the spectrum of possibilities for other kinds of 
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decision support systems is surprisingly wide. Obviously, some of these systems are of no 

particular use in many settings. Still, their variety suggests that most companies should have a 

number of genuine opportunities for applying the concept of computerbased support for decision 

making. 

 

Motives of Managers 

In fact, a wide range of purposes exists for these systems. While many decision support systems 

share the goals of standard EDP systems, they go further and address other managerial concerns 

such as improving interpersonal communication, facilitating problem solving, fostering 

individual learning, and increasing organizational control. 

Such systems can affect interpersonal communication in two ways: by providing individuals with 

tools for persuasion and by providing organizations with a vocabulary and a discipline which 

facilitates negotiations across subunit boundaries. 

Aids to communication 

Decision support systems also help managers negotiate across organizational units by 

standardizing the mechanics of the process and by providing a common conceptual basis for 

decision making. 

Value to user 

Although the implementers of a number of the successful systems studied found it necessary to 

go through the motions of presenting a cost/benefit rationale which attributed a dollar value to 

personal effectiveness, they didn’t believe these numbers any more than anyone else did. 

Management usually decided to proceed on the basis that the proposed system seemed to make 

sense and would likely have a beneficial impact on the way people interacted and/ or made 

decisions. 

 

The Systems View of Business: 

A system is a collection of parts (or sub-systems), which is integrated to accomplish an overall 

goal of an organization.  

▪ Systems have inputs, processes, outputs and outcomes, with ongoing feedback among 

these various parts. If one part of the system is removed, the nature of the system is 

changed.  

▪ Systems range from very simple to very complex. Social systems are comprised of 

numerous sub-systems, as well. 
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▪ These sub-systems are arranged in hierarchies and integrated to accomplish the overall 

goal of the overall system. Each sub-system has its own boundaries of sorts and includes 

various inputs, processes, outputs and outcomes geared to accomplish an overall goal for 

the sub-system. 

 

Any organization can be viewed as a system since an organization is a unitary whole. It 

consists of arrangement of activities to achieve its objectives. A system is an arrangement of 

activities designed to get something done. The systems approach studies the entire arrangement 

rather than a single sub-set of organizational activities. It considers an organization in its totality. 

 

Systems theory has brought a new perspective for managers to interpret patterns and 

events in their organizations. In the past, managers typically used to focus on one part at a time. 

The problem with that process was that an organization could, for example, have wonderful 

departments that operate well by themselves, but they might not integrate well together. 

Consequently, the organization suffers as a whole. 

 

Now, more managers are recognizing the various parts of the organization and, in 

particular, the interrelations of the parts, e.g., the coordination of central offices with other 

departments, engineering with manufacturing, supervisors with workers, etc. Managers focus 

more attention on matters of ongoing organization and feedback. 

 

They diagnose problems, not by examining what appear to be separate pieces of the 

organization but by recognizing larger patterns of interactions. They maintain perspective by 

focusing on the outcomes they want from their organizations. Now managers focus on structures 

that provoke behaviours to determine events, rather than reacting to events as was always done in 

the past. 

 

Thus every organization effectively functions through an integrated interlocking network 

of sub-systems. Any organization, as a system, possesses the following attributes: 

1. The system is goal oriented 

2. The whole is more than the sum of all parts in a system 

3. A system is engaged in processing or transformation of inputs into output 
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4. Various components of a system are interrelated and interdependent, and they interact 

with each other 

5. A system acts upon its environment and is also acted upon by the environment 

 

Therefore, an organization is considered as a system, as it draws input from the environment and 

also with other resource inputs like men, materials, machines and knowledge. An organization 

then processes these inputs and gets the output, i.e., the end product or services. Finally, with the 

feedback in its loop, it again tries to adjust with the environmental requirements. Systems 

approach in managing organization is followed primarily for following reasons: 

1. It lays emphasis on the dynamic character of business, considering it as a living organism 

2. It focuses on the interrelationship between business and the environment 

3. It stresses on the changing environment and accordingly adjusts through managing the 

change 

4. It provides information inputs for decision making and managerial control 

5. It guides formulation of business objectives, which are sustainable, keeping pace with the 

environment 

6. It subsumes organization as a whole, considering each unit or department of an 

organization as a part or sub-system. These sub-systems are both interrelated and 

interdependent 

7. Finally, it frames an integrated structure, incorporating each sub-system as the part of the 

total system 

Concept of systems in organization, primarily, emerged for the interconnectedness of 

phenomena, which could be external or internal to the organizations. With systems approach, an 

organization can manage the process of transformation from inputs to outputs. Although systems 

approach to organization has many manifestations, we are primarily concerned with the 

organizational structure part, which is better understood once we view an organization 

holistically. 

 

 

 

********** 


